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WARNING 

 

 

 

High Voltage 

is used in the operation of this equipment. 

 

LETHAL VOLTAGE on CONTACT 

may be present at measurement terminals, 

if you fail to take in all safety precautions! 

 

● When the RED indicator lights, lethal voltage (±10 kV dc/pulse) may ap-

pear at measurement terminals. 

● Usually use the interlock function 

● Do not operate the instrument unless another person is around the work 

space who is familiar with instrument operation and hazards or adminis-

tering first aid. 

● Potentials less than ±500 V may cause death under certain conditions. 

Therefore, adequate preventive measures must be taken at all times! 
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Agilent B1505A Power Device Analyzer/Curve Tracer is a powerful tool for measur-

ing and characterizing power devices.  

This quick start/self-paced demonstration guide for high-power devices up to 1500A 

and 10 kV covers the high power measurement capability and the unique features of 

the B1505A in step by step instructions. 

Each test included in this guide is covered with step by step instructions of cable 

connections to the test device and the parameter setting of the test, and you can 

easily set up the test and execute it by just following the guide. 

The target system configuration of this B1505A demo guide is newly introduced Ul-

tra High Current Unit (UHCU), High Voltage Medium Current Unit (HVMCU) and Ultra 

High Voltage Unit (UHVU). 

 

The step by step demo guide covers;  

● A cable connection from the instrument to the device terminal, 

● A test setup of the measurement parameters and the data extraction scheme, 

● A test execution and analysis on EasyEXPERT software which is resident in 

B1505A and provides all the control of the B1505A. 

 

Measuring high-power devices sometimes requires special knowledge of both the 

devices and the measuring instruments. 

For example, UHCU and HVMCU have the series resistor in the output port as like 

the so called curve tracer in the market, and it shows slightly different output V/I 

characteristics compared to the SMUs which output the exact V/I value as speci-

fied.  

The voltage and the current waveform in ultra high current measurement in pulsed 

test are easily distorted by the parasitic inductance of the measurement cables and 

the stray capacitance between the measurement cables. Sometimes the device os-

cillates very easily in high current operation region. Because of these effects, unex-

pected or doubtful test data may be coming out.  

There are many features in the B1505A to overcome these challenges, and these 

topics are covered in this demo guide. 

You can perform accurate measurement by following the steps of setup and the 

measurement instructions of this demo guide. 

 

 

 

 

 

 

 

 

Introduction 
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Chapter 1. Basic Knowledge of the B1505A 

Chapter 1. Basic Knowledge of the B1505A 

This chapter provides basic information related to the B1505A that is better to know 

before you start with the B1505A. 

The B1505A requires relatively complicated system configuration to fully utilize its 

high-power ranges. 

The objective of this chapter is to know the basic information of the B1505A test 

components that is essential to perform a successful measurement and to under-

stand the measurement results. 

This chapter covers the following topics; 

1. Agilent B1505A Power Device Analyzer/Curve Tracer 

- The B1505A test module information 

- The overall output V/I ranges of the B1505A 

- Output V/I ranges by each test module 

2. Agilent N1265A Ultra High Current Expander/Fixture 

- Built-in test module selector 

3. The effect of output R of UHCU and HVMCU 

- The effect of output R 

- The difference between SMU (no output R) 

4. EasyEXPERT Software 

There are following four test mode provided in the EasyEXPERT software. 

Each test mode has its unique features, and its key points are introduced in 

this guide.  

● Tracer Test 

● Application Test 

● Classic Test 

● Quick test 

B1505A Power Device Analyzer/Curve Tracer N1265A Ultra High Current Expander/Fixture
N1266A HVSMU Current expander

N1268A Ultra High Voltage Expander

Objective: 
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Chapter 1. Basic Knowledge of the B1505A 

Agilent B1505A Power Device Analyzer / Curve Tracer is designed to measure state 

of the art high-power devices from 1500 A to 10 kV, and the EasyEXPERT measure-

ment software resident on the B1505A is a specially-designed MS Windows® appli-

cation program. 

The B1505A mainframe can measure wide range of power devices from 10 fA to 

1500 A and 2 µV to 10 kV with 3,000 V CV measurement features. 

With the N1265A Ultra High Current Expander, the N1266A HVSMU Expander and 

the N1268A Ultra High Voltage Expander, the output range can be expanded to 

1500A and 10 kV. 

The EasyEXPERT software, which is resident on the B1505A, provides the real time 

curve tracer interface and an intuitive and flexible data management and analysis 

environment. 

B1505A Test modules: 

B1505A has 10 module slots, which support the following modules 

B1510A High Power SMU (HPSMU) 10 fA~1 A/2 µV~200 V 

B1511A Medium Power SMU (MPSMU) 10 fA~100 mA/0.5 µV~100 V 

B1512A High Current SMU (HCSMU) 10 pA~1 A/200 nV~40V (DC) or 10 pA~20 

A/200 nV~20 V (Pulse) 

B1513B High Voltage SMU (HVSMU) 10 fA~4 mA/200 µV~3000 V or 10 fA~8 

mA/200 µV~1500 V 

B1514A Medium Current SMU (MCSMU) 10 pA~100 mA/200 nV~30V (DC) or 10 

pA~1 A/200 nV~30V (Pulse) 

B1520A Multi Frequency CMU (MFCMU) 1 fF~10 nF @ 1 MHz with 0~3000 V DC 

bias by using High Voltage Bias-Tee with HVSMU. 

 

By adding the following expander box, the output voltage and current of the B1505A 

can be expanded. 

N1265A Ultra High Current Expander/Fixture (UHCU) 500 µA~1500 A/100 µV~60 

V (Pulse only) 

N1266A HVSMU Current Expander (HVMCU) 200 nA~110 mA/3 mV~2200V (DC) 

or 4 µA~2.5 A/3 mV~2200 V (Pulse) 

N1268A Ultra High Voltage Expander (UHVU) 10 pA~10 mA/10 mV~10 kV (DC) or 

10 pA~20 mA/10 mV~10 kV (Pulse)  

Note: 

Two MCSMUs are used to control each expander. If there is not enough 

MCSMUs installed in the B1505A, MCSMUs are shared between the ex-

pander. 

1-1. Agilent B1505A Power Device Analyzer/Curve Tracer 

Note: Windows, Windows NT, MS Windows, and Windows Vista are trademarks or regis-

tered trademarks of Microsoft Corporation in the United States and/or other countries. 
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Chapter 1. Basic Knowledge of the B1505A 

The overview of the output voltage and current range is shown in figure 1-1. 

The detail of the output and measurement range of each module are visually shown 

in figure 1-2. 
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Figure 1-1. B1505A output range with the Expander.  

* Decreases from the time zero value by the ratio of 

   exp(-PW/(0.22 µF x (Ro + R load) 

    where, PW: pulse width, Ro: 600 Ω or 2 k Ω.  

Figures 1-2(a). Output and measurement range (part 1). 
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Agilent N1265A UHC Expander (UHCE)/Fixture 

shown in figure 1-2 is used for measuring packaged 

power devices, It can basically covers the B1505A`s 

maximum output range; 1500 A and 10 kV. 

UHCU is a built-in test unit in N1265A, and it comes 

automatically in the configuration. 

The other measurement units are connected to 

N1265A UHCE/Fixture for packaged power device 

testing. 

We use N1259A option 020 High Voltage Bias-Tee 

for capacitance measurement.  

1-2. Agilent N1265A UHC Expander/Fixture 

Figures 1-2. Agilent N1265A UHC Expander/Fixture.    

Figures 1-3. Example connection of the built-in selector of N1265A Expander/Fixture    

Drain/Collector supply is automatically switched between the modules 

N1265A includes a built-in selector as shown in figure 1-3, and the drain/collector 

supply can be switched between UHCU, HVSMU/HVMCU and MPSMU/HPSMU. 

Therefore, the measurement can be continued without changing the wire connec-

tion between the each measurement unit, and it eliminates any errors related to the 

cable reconnection and it also reduces the test time. 

In the HVSMU path, a 100 kΩ series resistor can be inserted for breakdown test. 

In the gate channel, a series resistor from the choice of 0 Ω, 10 Ω, 100 Ω and 1 kΩ 

can be selected to control the stability of the measurement. 
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Max. I = Vcomp/Rout

Vcomp

Max. I = Vcomp/Rout

There is an output series resistor (Rout) in the Hi Force output of UHCU and HVMCU 

outside the voltage source (Vcomp) as shown in figure 1-4(a). The cable resistance 

Rcbl is also connected in series to the Rout.  

Since there is no mechanism to compensate the voltage drop by these resistors, the 

voltage appears at the DUT terminal is different from the Vcomp value which is set 

by the user. 

Figure 1-4(b) shows a typical measurement curve measured by the circuit shown in 

figure 1-4(a). The drain sweep end points for each gate steps align on a strait line 

determined by Vcomp/Rout or Vcomp/(Rout+Rcbl). 

 

It is generally not a problem if you just want to check a curve, but it will be a prob-

lem if you want to; 

- Add specific voltage without knowing the current value 

- Measure high current, but do not want to apply a high voltage (close to Vcomp) 

as shown in figure 1-4(b). 

 

Vm

Hi Force

Hi Sense

Lo Force

Lo Sense
DUT

0 V

Vcomp

If

Rout
Im

Rcbl

Figure 1-4 (a). Simplified block diagram    

Figure 1-4. The effect of output resistor.    

Figure 1-4 (b). Typical measurement curve under the Rout.    

Tips: 

Measured voltage is accu-

rate because the actual 

voltage at the DUT termi-

nal is sensed and used for 

plotting the curve. 

1-3. The effect of output R of UHCU and HVMCU 
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Reference information: 

◆ SMU case 

Figure 1-5(a) shows a simplified block diagram of HP SMU and MP SMU.  

The resistive components in the output block of these modules including the resis-

tance in the test cable are located inside the sense loop (refer to  and  of 

figure 1-5), and an accurate set voltage appears at the DUT terminal. 

Figure 1-5(b) shows a typical Id-Vd measurement example of SMU. 

The sweep end points for each secondary gate step parameter are aligned in vertical 

at the sweep end voltage. 

It means, in the case of SMU, you can make measurement at the specific voltage 

which you set independently to the load condition. 

This is a big difference compared to the results in figure 1-4(b) where the sweep end 

voltage varies depending on the load current and the output resistance. 

Note: Since there is no passive resistive component which works as a protective 

component when DUT breakdowns or sudden short in the SMU side, this ar-

chitecture may be not the best choice in high power applications.  

1 2

Feedback

HP/MP

SMU

Vm

Im

Vf

GNDU

0 V

DUT

0 V

If

Force

Sense

GNDU Force

GNDU Sense

1

2

3

Rcbl

Rs

Figure 1-5(a). Simplified Block Diagram of HP/MPSMU. 

Figure 1-5(b). Typical Id-Vd example of SMU. 
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Four Test modes available 

The EasyEXPERT software as a graphical user interface (GUI) of the B1505A has four 

types of TEST mode available: Tracer Test, Application Test, Classic Test and Quick 

Test.  

Each TEST mode has its unique capabilities and using an appropriate TEST mode that 

fits to your test requirement is important for getting a better result sooner. Following 

describes briefly about the B1505A`s TEST mode.  

 

1. Tracer Test mode 

In high-power test application that requires more than 20A, UHCU is a main meas-

urement module.  

If the maximum current is 1 ~ 2 A in a few hundreds voltage, then HVMCU is a 

choice in the measurement. 

If you use UHCU or HVMCU, Tracer Test mode is definitely the first priority choice of 

the Test mode.  

Tracer Test mode shown as an example in figure 1-6 provides an interactive curve 

tracer interface that allows parameters to be modified in real time during a measure-

ment using the B1505A’s front panel knob. For example, the drain voltage of the Id-

Vd sweep can be manually changed by rotating a knob of the B1505A like rotating a 

voltage dial of the curve tracer.  

The other parameter can be also changed while in measurement on the fly, and you 

can determine your test condition and the result quickly. 

Tracer test includes the following nice capabilities to support your test; 

● Sample setup for MOSFET, Diode, IGBT and BJT for typical measurement. 

You can start measurement by just filling in the measurement parameters. 

● Oscilloscope view that monitors the pulse waveforms of both the voltage and the 

current of your selected measurement point. 

● Stop condition where the measurement automatically aborted when the set con-

dition met.  This function is useful for breakdown test. 

● Reference trace that is shown in background of the measurement display, and 

you can compare the change between the reference and the current measure-

ment traces. 

● Replay traces function recalls the past measurement traces. For example, you 

can recall the past measurement traces until the device is breaks down and de-

stroyed. 

● Compliance to limit the primary sweep steps (VAR1) after a specified value 

- Power compliance 

- Current compliance 

- Voltage compliance 

● Marker and line function 

1-4. EasyEXPERT Software 
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5

1

3

46

2

Tracer Test Sample menu: 

The Tracer Test Sample menu is a good start point to create a high-power device 

test setup. If you choose a test sample from the menu, it is already filled out by a 

default test setups and parameters reflecting the B1505A configuration. Therefore, 

you can start editing your test setup from that point, and start measurement faster.  

You can refine the test setup by following the step numbers shown in figure 1-6. 

Tips: 

There is another way to use the Tracer Test mode.  

Since the Tracer Test setup can be easily converted to a Classic Test setup, you 

can use Tracer Test mode as an easy test setup and test debugging tool.  

The example test setup will automatically create a complicated test setup, and the 

interactive curve tracer interface helps for refining the final new test setup. 

Then, you can convert the completed setup to a Classic test for repeated use with 

a fixed measurement parameters or adding extra display traces and analysis func-

tionalities such as the automatic marker or lines. 

Figure 1-6. Example Tracer Test mode GUI.  

Note of the Tracer Test GUI: 

The following number shows the basic steps to start meas-

urement. 

1. Tracer Test selection tab 

2. Tracer Test Sample menu 

3. Channel definition area 

4. Measurement parameter setup area 

5. Single/Repeat measure button 

6. Rotary knob to control sweep/measurement parameters 

Tracer Test Sample menu 
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2. Application Test mode 

Application Test mode includes a library of pre-defined tests that eliminate the need 

to manually set up most instrument parameters for common device tests (such as Ic

-Vce measurements). The user can perform a measurement through an intuitive “fill 

in the blanks” process. Measurements are performed and parameters are automati-

cally extracted with just a simple click of the measurement button. 

 

The Application Test mode shown in figure 1-7 is a pre-defined test library coming 

with the B1505A and it includes a basic and frequently used test, for example, Id-Vd 

measurements. The user can start measurements by just typing in the measurement 

parameters and the test results with a proper data which is automatically extracted 

by the measurement is coming out by just pressing the Measure button. 

It is simple and very easy for adding modifications like the example. You can refer to 

the application note B1500A-4 “Customizing Agilent B1500A EasyEXPERT Applica-

tion Tests”, Agilent P/N: 5989-5167EN. 

As a conclusion, Application Test is the best choice if it satisfies your requirement. 

If not, there are two choices; one is to modify the existing Application Test defini-

tion, and the other is going to Classic Test mode. 

1. Enter the Test Parameters 2. Press the Measure Button

Figure 1-7. Application Test GUI. 
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3. Classic Test mode 

Classic Test mode provides complete access to all of EasyEXPERT software’s meas-

urement and analysis capabilities.  

Measurement setups created in tracer test mode can be imported into classic test 

mode and auto-analysis calculations can be added to them. The resulting Classic 

Test setups can then be used both interactively and for automated testing. 

Any application that is not covered in the Application Test library can be covered by 

using the Classic Test mode. 

Figure 1-8 shows an example Classic test setup window where;  

1. Channel Setup page,  

2. Measurement Setup page and  

3. optional SMU parameter setup sub-panels and  

4. Display setup page that is minimum pages you have to fill in before starting 

measurements. 

1.

2.

3.

4.

Figure 1-8. Example Classic Test measurement parameter setup panels.  
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Setting up a new Classic Test definition requires more knowledge as like the con-

nection between the device and SMUs of the B1505A and the function setup of the 

SMUs as shown in figure 1-8 compared to the pre-defined Application Test.  

Generally speaking, the user can interact more directly to the SMU control in the 

case of Classic Test compared to the Application Test which is somewhat black box 

to the user until knowing the inside setup by sneaking in the Application Test defini-

tions. 

 

4. Quick Test mode 

Quick Test mode provides a convenient means to automate test setups created in 

Tracer Test, Application Test or Classic Test modes without the need to do any pro-

gramming. You can automate test sequences for both a test fixture and for on-wafer 

testing across an entire wafer using the wafer prober drivers furnished with EasyEX-

PERT. 

The selected tests are 

sequentially executed.

Figure 1-9. Quick Test executes selected test sequentially.     
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Chapter 2. Preparation for the Measurements    

There are potentially hazardous voltages (10 kV for UHVU, 3 kV for HVSMU, 2.2 kV 

for HVMCU, and 200 V for HPSMU) present at the Force, Sense, and Guard termi-

nals of Agilent B1505A. To prevent electrical shock, the following safety precau-

tions must be observed during the use of B1505A. 

 

● Use a three-conductor AC power cable to connect the cabinet (if used) and 

B1505A to an electrical ground (safety ground).  

● You must connect an interlock cable between B1505A and the test fixture. 

● Confirm periodically that the interlock function is functional. 

● Do not modify the interlock circuit. 

● Do not use extension cables for connecting the DUT the outside of the test 

fixture except a wafer prober which provides the equivalent safety of the test 

fixture..  

● Before touching the connections on the Force, Guard, and Sense terminals, 

turn the B1505A off and discharge any capacitors. If you do not wish to turn 

the B1505A off, complete all of the following items, regardless of the B1505A 

settings. 

  - Press the Stop key to turn the module output off. 

  - Confirm that the High Voltage indicator is not lit. 

  - Open the shielding box access door. 

  - Discharge any capacitors connected to an SMU. 

 

WARNING    

2-1. Before using B1505A    

Chapter 2 covers the following preparation of the B1505A before starting B1505A 

measurement. 

1. Before using the B1505A 

2. Instruments and Accessories used in the demo 

3. Devices used in the demo 

4. Cable Connection between the B1505A and the Expanders/Fixture 

5. Starting the B1505A 

6. Updating the Application Test Library for EasyEXPERT rev. A.05.00 

 

The objective of this chapter is to start the B1505A and setup EasyEXPERT to pre-

pare for the measurement. 

Objective: 



20  

Chapter 2. Preparation for the Measurements 

We use the following B1505A configuration in the measurement example,  

 

 

 

Agilent B1505A Power Device Analyzer/Curve Tracer configuration: 

The standard B1505A demo configuration includes the following test modules. 

● 1 X HVSMU  (B1513B) High Voltage SMU 

● 1 X HCSMU  (B1512A) High Current SMU 

● 4 X MCSMU  (B1514A) Medium Current SMU 

● 1 X MFCMU  (B1520A) Multi-Frequency CMU 

● 1 x MPSMU (B1511A) Medium Power SMU 

● 1 x GNDU  Ground Unit (furnished in the B1505A main frame) 

 

Expanders and Cables used in the demo: 

Figure 2-2 shows the N1265A UHC Expander/Fixture, N1266A HVMC Expander and 

N1268A UHV Expander. 

Figure 2-3 shows the cables used for connecting between these Expanders/Fixture 

and the B1505A. 

Figure 2-4 shows the test wires/cables used inside the test fixture. 

2-2. Instruments and Accessories used in the measurement examples 

Figure 2-1. B1505A configuration used in the example.  

HVSMU

HCSMU

MPSMU

GNDU

MCSMU

MCSMU

MCSMU

MCSMU

MFCMU

To Drain/Collector of the 

N1265A Selector input

To Gate

To V/I control input of the 

N1265A/N1266A/N1268A expander

To Drain/Collector of the 

N1265A Selector input

or 

N1266A HVMCU input

For capacitance measurements

Extra modules for special requirements.

(Not used in std. demo configuration.)
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N1265A UHC Expander/Fixture N1266A HVMC Expander N1268A UHV Expander 

Figures 2-2. Agilent N1265A UHC Expander/Fixture, N1266A HVMC Expander and n1268A UHV Expander.    

Figure 2-3. Cables used for connecting between the B1505A and N1265A/N1266A/N1268A Expander/

Fixture.    

16494A Triax Cable

N1300A  CMU Cable
16493J Interlock Cable

16493S HCSMU Cable

16493T HV Triax Cable

16493V UHV Cable:

High side

16493V SHV cable:

16493L GNDU Triax Cable

16493G Digital I/O Cable



22  

Chapter 2. Preparation for the Measurements 

 

Figure    2-4. Cables/Wires used for connecting inside the fixture.    

Collector/Drain & Emitter/Source

Force line wire

Universal Force/Sense line wire

SHV cable and SHV-Banana Adaptor 

for capacitance measurement

UHVU test cable

N1260A High Voltage Bias tee 

N1265A-041    
Thermocouple 
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The following devices are used  for measurements through this guide. 

The device types are selected  to cover the maximum output range of the B1505A 

as; 

- High current MOSFET (HCMOS): IRFP4004 to cover over 500A. 

- High voltage MOSFET (HVMOS): IXTH1N250 to cover over 2500 V. 

- IGBT: FGA180N33ATD to cover medium voltage and current (330 V, 450 A) 

- High voltage diode: GP-02-40 to cover 4 k ~ 8 kV (2ea. series connected). 

Typical specifications of demo devices 

1. High Current Power MOSFET: IRFP4004Pbf 

  o VDSS: 40 V 

  o Rds(on): Typ. 1.35 mΩ   (1.70 mΩ  max.) @ Vgs=10 V, Id=195 A) 

  o ID max.: 350A @ 100 µs pulse, VD=10V 

                  1390 A @ Vd=2.5 V 

  o SOA: 3.5 kW @ Tc=25 °C, 100 µs pulse  

  o Vth: 2~4 V @ Id=250 µA 

  o Coss: 2360 pF typ. @ Vd=25 V 

2. High Voltage Power MOSFET: IXTH1N250 

  o VDSS: 2500 V 

  o Rds(on): Max. 40 Ω  

  o ID max.: 6 A @ 100 µs pulse, 5 kW @ Tc=25 °C 

  o SOA: 3 kW @ Tc=25 °C, 100 µs pulse  

  o Vth: 2~4 V @ Id=250 µA  

  o Coss: 77 pF typ. @ Vd=25 V 

3. IGBT : FGA180N33ATD 

  o VCES: 330 V 

  o VCE(sat): Typ. 1.68 V @ Ic=180A 

  o ID max.: 450 A @ 100 µs pulse, VC=16V 

  o SOA: 7.5 kW @ Tc=25 °C, 100 µs pulse 

  o Vth: 2.5~5.5 V (typ.=4 V) @ Ic=250 µA 

  o Coss: 305 pF typ. @ Vc=30 V 

4. Ultra High Voltage Diode: GP02-40 

  o VRRM: 4,000 V 

  o IF (AV): 0.25 A 

  o IR @ 4 kV: 5 µA @ 25 °C 

2-3. Devices used in the measurement examples 

IRFP4004

HC MOS

GP02-40

4 kV Diode

FGA180N33ATD

IGBT

IXTH1N250

HV MOS

Figure    2-4. devices used in this guide.    
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Before starting the measurements, connect the cables between the B1505A, the 

N1265A Ultra High Current Expander (UHCE)/Fixture and the N1266A HVSMU Cur-

rent Expander (HVCE).  

The connection which is shown in this section is common for all the DC measure-

ments using the N1265A UHCU. 

Note: 

The configuration for ultra high voltage demo using the UHVU and the capacitance 

measurements demo uses different configurations. They are separately shown in 

that demo section.  

 

 

2-4. Cable Connection between the B1505A and the Fixture/Expanders for basic DC demo 

B1505A std. Demo configuration (back) 

Figure    2-5. Back side view of the B1505A and Expanders.    

N1265A (back) 

N1266A (back) 
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Cabling block diagram 

Figure 2-6 shows the basic cabling block diagram between the B1505A and the 

N1265A UHCE and the N1266A HVCE. 

 

Note: 

In the demo setup, we basically share only two V/I control MCSMUs between the 

N1266A HVCE and the N1265A UHCE. Therefore, four cable connection lines from 

two MCSMUs to control the N1265A UHCE are shown in solid line (see ). 

The four dotted lines (see ) to the N1266A HVCE mean that they are switched 

between the N1265A UHCE, but not connected this time. 

1

2

Figure    2-6. Basic cabling block diagram for UHCU and HVMCU.    

HVCE
N1266A

HV

GND

MC

MC

MC

B1505A

MC

MC

Interlock

GNDU

Input      Output

Input 

HVSMU

Output 

High

Output 

Low

F
S

F
S

F
S

Vcontrol F
Vcontrol S

I control F
I control S

F
S

F
S

Digital I/O cable (Included in N1266A)

Digital I/O cable (Included in N1265A)

Input

HVSMU

GNDU

N1265A (Selector built-in)

Gate F

Gate S

UHC Input 

V Control

I Control

For Gate

For UHC

For UHC

For Drain

For HVCE

For HVCE

16493T 16493T

16494A

16493L

16494A

16493L

Output

MCSMUs are shared between the 

configuration of the HVMCE and 

the UHCE`s control inputs.2

1

MP S
F Selector SMU F

Selector SMU S
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Figure 2-7. Cable Connection for N1265A UHCE and Test Fixture. 

MPSMU 1

MCSMU 3

GNDU

MCSMU 4

MCSMU 5

HVSMU

Sense

Sense

Sense

Sense

Force

Sense Sense Sense

N1265A, N1266A Back Panel

B1505A 

Back Panel

6

1
Digital I/O

Interlock

8 7
9

13

12

11

10

N1265A

N1266A

12

MCSMU 2

HCSMU 6

MFCMU

4

3

2

Force

Force

5

Connect the cables between the B1505A and the Expanders as shown in figure 2-7 

by following the step number 1 to 13 of figure 2-7. 

The breakdown of each steps with cable figures and the connector locations are 

shown in figure 2-9. 

Step number 1: 

Using a 16493L GNDU Cable, connect the GNDU on the B1505A to the GNDU 

Input on the N1266A. 

Step number 2: 

Using a 16494A Triax Cable, connect the Force and Sense connectors on the 

lower B1511A MPSMU (SMU1) to the respective connectors on the selector in-

put on the N1265A. 

Step number 3: 

Using a 16494A Triax Cable, connect the Force and Sense connectors on the 2nd 

SMU from the bottom (MCSMU2) to the “Gate Connect” input connectors of the 

N1265A. 
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Step number 4: 

Using a 16494A Triax Cable, connect the Force and Sense connectors on the 3rd 

SMU from the bottom (MCSMU3) to the “V control” connectors of the UHC input 

of the N1265A. 

Step number 5: 

Using a 16494A Triax Cable, connect the Force and Sense connectors on the 4th 

SMU from the bottom (MCSMU4) to the “I control” connectors of the UHC input 

of the N1265A. 

Step number 6: 

Using a 16493T HV Triax Cable, connect the Force connector on the B1513A 

HVSMU to the HVSMU input of the N1266A 

Tips: 

Make sure to screw in the connector firmly by hand to the end point where 

you feel some resistance. 

Step number 7: 

Using a 16493L GNDU Cable, connect the Low output of the N1266A HVMCU to 

the GNDU Input of the N1265A. 

Step number 8: 

Using a 16493T HV Triax Cable, connect the High output connector of the 

N1266A to the HVSMU connector of the selector input of the N1265A 

Step number 9:  

Using a 16493J Interlock Cable, connect the Interlock on the B1505A and the 

Interlock on the N1265A 

Tips: 

For connecting the interlock cable, hold the black plastic part and then turn 

the connector by pressing toward the interlock connector in the instrument 

side as shown in figure 2-8. 

For disconnecting the interlock cable, hold the metal part and then pull the 

connector by turning it.  

Step number10: 

Using a 16493G Digital I/O Cable, connect the Digital I/O connector on the 

B1505A to the Digital I/O Input connector on the N1265A UHCE/Fixture. 

Step number11: 

Using a 16493G Digital I/O Cable, connect the Digital I/O Output connector on 

the N1265A to the Digital I/O Input connector on the N1266A HVCE. 

Step number 12: 

Connect power cable to the B1505A, N1265A and N1266A. 

Pressing and      turn
Pulling and    turn

For connecting: For disconnecting:

Figure 2-8. Interlock connection. 
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Figure 2-9.  

Step 3

Step 2

Step 4

Step 1

Step 5

GNDU Cable

Triax SMU Cable

Triax SMU Cable

Triax SMU Cable

N1265A sideB1500A side

Triax SMU Cable

GNDU

MPSMU 1

MCSMU 2

MCSMU 3

MCSMU 4

Step 7

Step 6
B1500A

HVSMU

N1266A

Step 8 N1266A

N1266A

N1265A

GNDU Cable

N1265A

GNDU

GNDU

HVSMU

HV Triaxial Cable

HV Triaxial Cable

N1265A/N1266A side 

N1265A 

N1265A 

N1265A 

N1265A 

N1265A 
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Step 9

Interlock Cable

Interlock
N1265A

Step 10

Digital I/O Cable

Step 11

N1265A

B1500A

N1265A

Digital I/O Cable N1266A

Connect  Power Cables to all the B1505A, B1265A and B1266AStep 12

Digital I/O

Digital I/O

Output

Input

Input

Keyboard and mouse: Step number 13: 

Be sure to connect the keyboard and a mouse before starting the B1505A. 

Key Board Mouse
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The following operations are covered in this section.  

Step 1. Turn on the Agilent B1505A.  

Step 2. Starting the EasyEXPERT software.  

Step 3. Preparing for user specific work area in the EasyEXPERT Workspace. 

 

Step 1. Turning on the Agilent B1505A 

After you receive the B1505A, perform the following setup. 

1. Make sure that the Standby switch is set to off. 

2. On the B1505A rear panel, make sure the Circuit Common terminal 

is connected to the frame ground terminal with a shorting-bar. 

3. Connect the Agilent 16444A-001 USB keyboard and the 16444A-

002 USB mouse to the USB port of the B1505A. 

4. Connect the power cable from the B1505A to an AC power outlet. 

5. Open the measurement terminals (disconnect measurement de-

vices if they are attached), and press the Standby switch (lower 

right corner of the front panel) to turn on the B1505A. 

Windows, measurement module initialization, and self-calibration 

will start. 

6. The default Windows setup logs on to Windows automatically by 

the “Agilent B1500 User” which should be default user of the 

B1505A. 

Note:  

If you are the first user of the B1505A shipped from the Agilent 

factory, then you are required to perform the initial setup of the 

Windows operating system of the B1505A. 

 

Step 2. Starting EasyEXPERT 

After logging on, click the Start EasyEXPERT button. 

Wait until EasyEXPERT is activated. 

 

 

 

 

 

 

Note: 

If you close the Start EasyEXPERT window, you can run it again by clicking 

the following Start EasyEXPERT short cut on the Windows desktop. 

2-5 Starting the B1505A 

2-5-1 Starting the B1505A 
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Just after the Windows initialization, the EasyEXPERT start up window opens with 

one of the following three cases.  

Follow the instruction to setup the EasyEXPERT demo workspace. 

 

Close Workspace by selecting "Close 

Workspace” from the “File” menu,  

and return to the EasyEXPERT work-

space management window. 

Click "Close Workspace" 

change the panel to "Case 

2" Workspace Management 

window. 

Check the "No, I want to start a new 

session" radio button. 

Go to Step 3 of next page to create a 

new Workspace for demo use. 

Go to Step 3f of two pages from this 

page and create a new Workspace for 

demo use. 

Workspace Management window 

Case 1: First time use 

Case 2: One existing workspace 

Case 3: More than two existing workspace  
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Step 3. Preparing for user specific Workspace of EasyEXPERT 

Step 3a. Select the "No" radio button and click Next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3b. The following Workspace Configurator appears. 

We create a new workspace, and this workspace will be deleted on demo 

B1505A return. 

 

Enter, say, “Demo Workspace XX” as a unique name new workspace in the 

new workspace entry field. 

Step 3c. Click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to Step 3d of next page. 

 

3b. 

3c. 
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(Continued : Demo Workspace setup)  

Step 3d. Click the new "Demo Workspace XX" to highlight it. 

Step 3e. Click Continue. 

 

 

 

 

 

 

 Go to "Step 3j" of next page. 

 

 

 

 

 

 

 

Step 3f. Creating a new Workspace. 

If two or more workspaces already exist, B1505A displays the following Workspace Configurator. 

 

Step 3g. Click "Create a new  

              Workspace radio button 

 

Step 3h. Enter, say, “Demo Workspace 

XX” as a unique name new 

workspace in the new work-

space in the new workspace 

entry field. 

 

Step 3i. Click Continue 

 

 Go to "Step 3j" of next page. 

 

 

 

Note: 

Workspace means the space created in the Agilent B1505A’s internal hard disk 

drive, and is used to store the measurement setup, measurement result data, and so 

on. The workspace can be created and allocated for each user . 

3d 

3e 

Demo Workspace XX 
3g 

3h 

3i 
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Step 3j. The following new EasyEXPERT initial window opens. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Now, new “Demo Workspace XX” is created and the User Demo Setup is com-

pleted. 
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Power line frequency setting is very important for accurate and stable measure-

ments in low signal voltage or current. 

 

Please check your line frequency setting of your Demo B1505A. 

If the line frequency is set differently from your area's line frequency, please set it 

correctly by following the following steps. 

 

● To Change: 

1. Click "Configuration" button. 

Configuration window opens. 

2. Click Line frequency button to open the line frequency list. 

Select 50Hz or 60Hz. 

3. Click "Close" button. 

2-5-2 Power line frequency setting 

1

2

3
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Online Help is available for EasyEXPERT. 

Select  "Help > EasyEXPERT Help menu" to display the online help window. 

 

The online help provides the following information. 

● Introduction 

● Using EasyEXPERT 

● Function Details 

● Built-in Programming Tool 

● If You Have a Problem 

 

◆ To Display Help: 

Follow the next steps to display Online Help. 

1. Select "Help > EasyEXPERT Help menu". 

2. "Help" window opens.  

 

2-5-3 Online Help 

1.

2.
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Earlier demo B1505A system requires to modify and add the following EasyEXPERT 

Application Test library to satisfy the demo condition; 

 

Addition: 

● Id-Vgs for Expanders (A.05.01) 

● Ic-Vge for Expanders (A.05.01) 

Modification: 

● Vth Vgs(off): Vth or Vgs(off) measurement (A.05.00) 

● Vth Vge(off): IGBT Vth or Vge(off) measurement (A.05.00) 

 

You can check your EasyEXPERT revisions as follows. 

1. Click "Configuration" button. 

Configuration window opens. 

2. Check EasyEXPERT revisions here. 

If the first 5 letters are “A.05.00” as shown in the following figure, 

please go to Appendix 1, and make necessary changes. 

 

Note: 

If it is “A.05.01” or larger, there is no extra action required. 

 

3. Click "Close" button 

2-6. Updating the Application Test Library for EasyEXPERT rev. A.05.00 

1

2

3
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Chapter 3. Demonstration 1: Vth Measurement 

Getting familiar with the B1505A and the EasyEXPERT Test operation 

This chapter covers the following topics. 

1. Wiring and Device setting on the N1265A Fixture. 

2. EasyEXPERT configuration for expanders. 

3. The use of the Gate Rs to prevent oscillation (Tips). 

4. Vth measurement using the Application Test (Vd=Vg) 

5. Vth measurement using the Application Test (Vd=Const) 

 

The objective of this chapter is to become able to measure Vth of the demo devices 

by using the Application Test Library by following the above topics. 

 

By using the Application Test mode, you can expect to touch the following features; 

● GUI based: Easily understand the device connection. 

● Measurement parameters only: Typically, only the test condition parameters 

are enough to start measurements. Hardware setup is usually not required. 

● Auto-analysis: Generally the measurement includes the auto-analysis results of 

the device parameter. 

 

 

Demo 1 uses the following devices; 

● IPFP4004 PbF HC MOSFET 

● FGA180N33ATD IGBT (optional) 

● IXTH1N250 HV MOSFET (optional) 

 

 

 

Note: 

If your EasyEXPERT revision is A.05.00, you have to modify the application test 

definition before starting the Vth measurement. 

Refer to chapter 2-6 if you have not yet modified the Vth application test defini-

tion. 

 

Objective: 

Features: 

Device used: 



39  

Chapter 3. Demo 1 

Figure 3-1 shows the wiring inside of the N1265A UHC Expander/Fixture. 

Route the wire between the output terminal panel of the N1265A Test Fixture and 

the inline package socket module as shown in the figure. 

 

2. Collector/

Drain
1. Base/

Gate

Force       Sense Force       SenseForce       Sense

Base   Collector   Emitter

Gate      Drain       Source

3. Emitter/

Source

4

76

5
23

Inline Package Socket (3 Pin)

1  2  3  

1

Figure 3-1. Wiring inside of the N1265A Fixture. 

Collector/Drain & Emitter/Source

Force line wire

Universal Force/Sense line wire

2 3

3-1. Wiring and Device setting inside of the N1265A Fixture 

Follow the next steps to set up the wires inside the fixture by following the numbers 

on figure 3-1. 

Note: 

Use thick wire for  and that can withstand up to 1500 A. 

Use the thinner wire for other connections. 

 

Step 1. Make sure 3-pin inline socket module is set to the N1265A Fixture. 

If not, set the socket module as shown in figure 3-1, and tights the module 

by fixing the four pins located on the four corners of the socket module. 

Step 2. Connect the Low-Force of the Selector Output to the terminal 3 Low-Force 

(Emitter/Source) on the Inline Package Socket.  

Step 3. Connect the High-Force of the Selector Output to the terminal 2 High-Force 

(Collector/Drain) on the Inline Package Socket.  

2 3
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Step 4. Connect the Low-Sense of the Selector Output to the terminal 3 Low-Sense 

(Emitter/Source) on the Inline Package Socket.  

Step 5. Connect the High-Sense of the Selector Output to the terminal 2 High-Sense 

(Collector/Drain) on the Inline Package Socket.  

Step 6. Connect the Low of the Gate Output to the terminal 3 Low-Sense (Emitter/

Source) on the Inline Package Socket.  

Step 7. Connect the High of the Gate Output to the terminal 1 Force (Base/Gate) on 

the Inline Package Socket.  

 

Note: 

The connections shown in this section are common for all the DC measurement 

using the N1265A UHCU and 1266A HVMCU. 

 

 

3-2. Test Device setup 

Set the test device (DUT) as shown in figure 3-2. 

This time, we set the HC MOSFET: IRFP4004Pb. 

Insert the MOSFET to the 3-pin socket (From the left, it is Gate, Drain and Source). 

G   D   S

G   C   E

G: Gate

D: Drain

S: Source

C: Collector

E: Emitter

Device

Figure 3-2. DUT setup. 

G    D    S

IRFP4004 

HC MOS 
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�To Configure UHCU: 

Each expander has to be configured before the use after the power on-state. 

Note: Before proceeding to the configuration, make sure the cable connection is 

properly made as shown in figure 2-7 

Follow the next instruction by following the steps shown in figure 3-3. 

Step 1. Click Configuration icon. 

Step 2. Click "UHC Expander / Fixture" tab. 

Step 3. Click and mark the check box of "Enable Ultra High Current Unit". 

Step 4. Select exact the same Control SMUs for the V/I control SMUs` drop down 

list as you have configured in the B1505A cabling section. 

i.e. SMU3:MC for V Control SMU, and SMU4:MC for I Control SMU. 

Step 5. Click and mark the check box of "Enable Selector". 

Step 6. Leave blank for HVSMU if HVSMU is not yet configured in the “HVSMU Cur-

rent Expander” tab. 

Note: Select SMU5:HV for HVSMU if it is available. 

Step 7. Select SMU1:MP for SMU. 

Step 8. Click and mark the check box of "Enable Gate Control". 

Step 9. Select SMU2:MC for gate control SMU. 

Step 10. Set 100 ohm to the output of the Gate Control SMU as a default value. 

There are 0, 10, 100 and 1000 ohm choice.  

Note: Selecting 0 ohm easily shows device oscillation and it is not recom-

mended. 

3.
4.

5.

7.
6.

9.

8.

11.

12.

13.

14.

16.

1.
2.

10.

15.

3-2. EasyEXPERT Configuration for Expanders 

Figure 3-3. UHCE/Fixture 

configuration. 
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Step 11. Click "Apply" button.   

The configuration is checked, and step 12 follows. 

Step 12. Field #12 and #13 are filled automatically depending on previous EasyEX-

PERT setting.  

The power indicator changes from orange to yellow, and the selector out-

put indicator shows the currently active unit as shown in #15. 

Step 13. You can change the default output module here.  

Set SMU1:MPSMU as a default in this section.  

 

Note: This setting will generate the switching relay sound when switching 

from the default to UHC. 

Step 14. Click "Apply" button to renew the active selected module. 

Step 15. The selector indicator of N1265A front panel changes to the current selec-

tor status: SMU. 

Step 16. Click "Close" button to close the Configuration window. 



43  

Chapter 3. Demo 1 

There are three built-in switchable gate resistors and one short path in the Gate 

control of the N1265A UHC Expander/Fixture as shown in figure 3-4. 

This resister is used to prevent  device oscillation, and the resistor value is chosen 

by considering the circuit stability (margin to an oscillation), pulse width and the 

device capacitor component between the drain gate of power MOSFET and collector 

gate of IGBT. 

Generally speaking, when the capacitor component is larger and pulse width is 

shorter, a smaller gate resistor is required. 

 

Note: 

We typically use 100 Ω in the demonstration except if it is specified a different value 

on a demo instruction. 

3-3. The use of the Gate Rs    to prevent oscillation (Tips). 

Figure 3-4. Gate R. 

Gate Control Module Selector

F: Force

S: Sense

100 Ω is used 

as a std. gate R 

in the demo.

Built-in, switchable series 

resistor to avoid device 

oscillation 



44  

Chapter 3. Demo 1 

First step of the power device measurement is to know the gate threshold voltage 

(Vth) or cutoff voltage. 

Vth measures the gate voltage which turns on the drain/collector to source/emitter 

channel, and can be considered as the reference point to set the gate parameters of 

the power MOSFET/IGBT. 

There are several ways to measure and characterize the Vth as shown in figure 3-5. 

In the power device measurement, the Vth is traditionally measured by connecting 

the gate and the drain/collector together to overcome the measurement resource 

limitation of the traditional curve-tracer. 

Because of this, typically, the datasheet specification of the power MOSFET uses 

this test method for Vth extraction. 

But this method requires the extra connection between the gate and the drain/

collector pins, and it complicates the test setup. 

The B1505A can make measurement with the same way, but we have a better way. 

By emulating this measurement by using two SMUs, we can extract the exact Vth 

without changing the cable connections of the device, and the capability without 

manually changing the cable connection is an important point for measuring the 

device parameters. 

We demonstrate Vth extraction by using two SMUs. 

Demo 1. Vth measurement using the Application Test 

Both the Gate and the 

Drain voltage sweep at 

the same potential by 

synchronizing two SMUs.

Traditionally, the Vth is measured by connecting the 

drain and the gate together by using a traditional  

curve-tracer.       Gate connection has to be changed!

But, B1505A can measure exactly the same by 

synchronously sweeping the gate as the same voltage 

of the drain.  

Cable reconnection is not necessary.

Vth extraction by B1505A

Vth @ Vd = Vg

Vth @  Id= 250 uA

Figure 3-5. Vth measurement. 
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Demo 1-1 demonstrates the Vgs(off) test of the Vth Vgs(off) Application Test. 

This test sweeps both the gate and the drain in the same voltage. 

Follow the next steps to measure vgs(off) of IRFP4004 high current power MOSFET 

by following the number  of figure 3-6. 

Step 1. Click “Application Test” mode tab. 

Step 2. Click PowerMOSFET Category. 

Step 3. Enter “Vth” to the search field. 

Step 4. Click “Vth Vgs(off)” Application Test, and click Select. 

Step 5. Vth Vgs(off) Application Test definition GUI opens. 

Enter or select the next test parameters to the GUI. 

 

 

 

 

 

 

 

Note: Vd setup is ignored in the Vgsoff MeasMode, and the gate term is applied to 

the drain. 

Demo 1-1. Vth Vgsoff Application Test 

Vgsoff measurement using the Application Test (@ Vd=Vg) 

2.

1.

3.

4. 5.

6.

8.7.

Figure 3-6. Vth Vgs(off) application Test. 

MeasMode Vgsoff Drain SMU1:MPSMU

IntegTime SHORT Vd 1 V

Gate SMU2:MCSMU IdLimit 10 mA

VgStart 1 V Id@Vth_Vgsoff 250 uA

VgStop 5 V

VgStep 20 mV Source GNDU
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Step 6. Click the Extended Setup. 

Extended Setup window opens. 

Set the parameters as the same shown in the following picture. 

Step 7. Change the Setup Name as “Vgs(off)”. 

Step 8. Click Single measure  button. 

The measurement starts. 

Step 9. The measurement results are shown up in the Data Display window with 

Automatic analysis of markers (see #11) and the Vgoff parameter extraction 

in the Parameters area (see #12). 

Step 10. Test Result Editor opens. 

You can add remarks, flags and select Save/Delete decisions. 

Click OK to reflect your decision.  

The default of this editor is OK when you make any other action, and the 

data is automatically saved in the Result area (The bottom of EasyEXPERT 

GUI). 

 

   Note: You can set your save options in the “Run Options” button. 

Step 11. The markers automatically located at Id=250 µA 

for both linear Y1 axis and log Y2 axis. 

Step 12. Vgsoff measured at the marker position (interpolation)  

is displayed: 3.23 V. 

10.

9.

12.

11.

Figure 3-7. Vgs(off) application Test result. 
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After the measurement is made and the results are satisfactory, you can save the 

test setup for the future use. 

 

Follow the next steps to save your test setup by following the number in figure 3-8.. 

Step 1. Click “My Favorite Setup. 

Step 2. Click “Preset group”. 

Step 3. Click Add New Preset group. 

Step 4. Enter a group name, for example “Demo”. 

A new preset group name shows up in My Favorite Setup group. 

 

Note: You can export or import the test setup with a unit of the preset group. 

 

Step 5. Click “Save” will save your test setup with the name in “Setup name:” field. 

Step 6. Optional 

If you scroll the vertical bar of the Test Parameters GUI, the Vgs(off) GUI with 

a dotted line connection that indicates the gate and the drain SMUs are syn-

chronized in the sweep. 

 

Review: 

● The measured Vgsoff at Id=250 µA is 3.23 V.  

The specification is between 2 to 4 V, and the measurement result is reason-

able. 

● Application test is handy and very convenient if the application test definition 

meets the requirement. 

1.

3.2.

4.

5.

6.

Figure 3-8. Save the setup to “My Favorite Setup”. 
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This demo uses the same setup of demo 1-1, but Vd is set to a constant voltage, at 

1 V. 

Change the demo 1-1 setup by following the next steps and the numbers shown in 

figure 3-9. 

Step 1. Change MeasMode to “Vth”. 

Step 2. Change Setup name to “Vth”. 

Step 3. Save the test setup to Demo preset group. 

Step 4. The setup is saved. 

Step 5. Press Single Measure button. 

Measurement starts. 

Demo 1-2. Vth Vgsoff Application Test 

Vth measurement using the Application Test (@ Vd=constant) 

2.

1.

3.

4.

5.

Figure 3-9. Vth Vgs(off) application Test: Vth measurement. 
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Test result is shown in figure 3-10. 

Vth is extracted as 3.23 V and the result is almost the same as figure 3-7 display 

though the Vd is fixed to 1 V. 

● Save the test results. 

Figure 3-10. Vth test result. 

Review: 

Generally speaking, Vth or Vgs(off) measurement shows almost the same data if Vth 

measurement is made at saturation region. Usually Vd=1 V satisfies this condition. 

 

 

Other assignment of the demo: 

● Try Vth or Vgs(off) measurement to IGBT and HV-MOSFET. 

- IGBT: Use “Vth Vge(off) application test definition. 

   Use the same test parameter of demo 1. 

- HV MOSFET: Use the same Application Test and parameters used in Demo 1. 

 

Tips: 

● For Id-Vd or Id-Vg measurement, it is a good idea to set the Vg start voltage as 

close value of Vth.  
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Chapter 4. Demo 2 

4-1. Wiring and Device setting inside of the N1265A Fixture 

4-2. EasyEXPERT Configuration for Expanders 

4-3. What is Tracer Test Execution mode? 

4-Demo 2-1. Id-Vd Tracer Test 

4-Demo 2-2. Id-Vd Tracer Test: Oscilloscope View 

4-Demo 2-3. Rds-ON Characteristics 

Demo 2-3-1. Rds ON Characteristics (Rds On vs. Id) 

Demo 2-3-2. Rds ON Characteristics (Rds On vs. Vg) 

4-Demo 2-4. Ic-Vc (IGBT) Tracer Test  

4-Demo 2-5. Vce-sat (IGBT) Test 

Chapter 4. Demonstration 2: UHCU Tracer Test 

Ultra High-Current Measurement using UHCU with Tracer Test mode 

Contents: 
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Chapter 4. Demo 2: 

This chapter covers the following test. 

1. Id-Vd (HC MOSFET) 

2. Oscilloscope View 

3. Rds on (HC MOSFET) 

4. Ic-Vc (IGBT) 

5. Vcesat (IGBT) 

 

The objective of this chapter is to perform the above test and understand B1505A`s 

unique measurement capabilities by using the Tracer Test mode. 

 

This section covers following B1505A features; 

● 1500A measurement capability through 500 A test (Current limited by the test 

fixture capacity) 

● Both the current and voltage compliance mode 

● Power compliance mode 

● Arithmetic operation function (Rds extraction) 

● I force capability (Vce-sat measurement) 

● Oscilloscope View 

● Replay Traces 

 

Demo 2 uses the following devices; 

● IPFP4004 PbF HC MOSFET 

● FGA180N33ATD IGBT 

 

Use the same setup of section 3-1 and figure 3-1. 

Chapter 4. Demonstration 2: UHCU Tracer Test 

Ultra High-Current Measurement using UHCU by using Tracer Test mode 

Objective: 

Features: 

Device used: 

4-1. Wiring and Device setting inside of the N1265A Fixture 

G   D   S

G   C   E

G: Gate

D: Drain

S: Source

C: Collector

E: Emitter

Device

Figure 4-1. DUT setup. 

G    D    S

IRFP4004 

HC MOS 

G  C  E

FGA180N33ATD 

IGBT 



52  

Chapter 4. Demo 2 

�To Configure UHCU: 

Each expander has to be configured before the use after the power on. state. 

Note: Before proceeding to the configuration, make sure the cable connection is 

properly made as shown in figure 2-7. 

Follow the next instruction by following the steps shown in figure 4-2. 

Note: If SMU3:UHC is active in step 12, then you can skip the following 

step 1 to step 12, and start from step 13 of next page. 

 

Step 1. Click Configuration icon. 

Step 2. Click "UHC Expander / Fixture" tab. 

Step 3 to 10:  

The setup should be the same if you come from the demo 1. 

If not, please set the configuration by following the steps shown in section 3

-2. 

Step 11. Click Apply button. 

Step 12. SMU3:UHC1 appears as active module. 

 

4-2. EasyEXPERT Configuration for Expanders 

3.
4.

5.

7.
6.

9.

8.

11.

12.

1.
2.

10.

Figure 4-2. UHCE/Fixture 

configuration 1. 
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Refer to Figure 4-3 for the following steps. 

Step 13. Change Output Default SMU from “SMU1:MP to “SMU3: UHC1” 

Step 14. Click "Apply" button to renew the active selected module. 

Step 15. The selector indicator of N1265A front panel changes to the current selec-

tor status: UHCU. 

Step 16. Click "Close" button to close the Configuration window. 

13.

14.

16.

Figure 4-3. UHCE/Fixture 

  configuration 2. 

15.
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The Tracer Test mode provides traditional and familiar curve tracer functionality, 

permitting quick device characterization with minimal measurement setup effort.  

An Oscilloscope view allows you to monitor the pulse measurement waveforms with 

2 µs resolution. 

Large current signals applied to the collector can be distorted by parasitic compo-

nents (such as the cable inductance of the test setup), and these parasitic compo-

nents can lead to unexpected measurement results. 

The Oscilloscope View helps to prevent this by providing the exact waveform shapes 

as well as the relative positions of the collector and the gate signals. This allows 

you to adjust your timing parameters so as to achieve optimal measurement condi-

tions.  

An innovative automatic recording feature prevents data loss even if the device un-

der test (DUT) is inadvertently destroyed.  

In addition to these impressive measurement capabilities, the intuitive EasyEXPERT 

software environment makes data analysis a snap. You can also easily export data 

into your PC-based work environment and use this data to generate presentations 

and reports. 

The pre-defined setup menu of the Tracer mode makes the IV test setup a lot easier 

especially in complicated setups such as pulsed measurement.  

This setup can be converted to the Classic Test mode test definition, and it is a con-

venient functionality for creating  a classic test from a scratch. 

Step 1: Click Tracer Test tab. 

Tracer Test mode screen shown in next figure opens. 

Step 2: Define the source and measurement channels. 

Step 3: Set the source output parameters. 

Step 4: Connect DUT, and click the Single button to start a single measurement. 

Step 5. Note: Repeat measurement is used to change the measurement parame-

ters while in measurement. 
 

4-3. What is Tracer Test Execution mode    

To perform Tracer Test: 
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Chapter 4. Demo 2-1: Id-Vd Tracer Test 

1 

10 

100 

1,000 

10,000 

1 10 100

Id
s
  
(
A

)

Vds (V)

Maximum Safe Operating Area

Tc=25 °C

Tj=175 °C

Single Pulse

100 µsec

1 msec

To learn the following topics; 

● How to setup test 

● How to execute the interactive sweep 

● Current and voltage compliance mode 

● Power compliance mode 

● Replay Traces 

 

Demo device 

Set IRFP4004PbF to the 3 pin in-line Socket as shown in the next figure. 

 

 

 

 

 

 

 

 

 

 

Following shows a brief information of SOA area and the capacitance information of 

the device. Refer to section 2-3 for the device specification. 

Demo 2-1: Id-Vd measurement using the Tracer Test 

Objective: 

G   D   S

G   C   E

G: Gate

D: Drain

S: Source

C: Collector

E: Emitter

Device

G    D    S

IRFP4004 

HC MOS 

Demo 2-1-1.  

100 

1,000 

10,000 

100,000 

1 10 100

C
a
p
a
c
it

a
n

c
e
 
(p

F
)

Vds (V)

Capacitance vs. Vds

Ciss

Crss

Coss

- Since the feedback capacitor from the drain to the 

gate (Cdg) is large, the gate is better to use a pulse 

drive rather than DC.  

The gate voltage is over driven by the charge from 

the drain pulse, and excessive Id may flow at the 

timing of Vd pulse rise-up if the gate is driven by DC. 

Vdss 40 V

1.35 mΩ

1.70 mΩ

Id (pulse) 1390 A *

  * Tj<175 °C

Rds (on) typ.

            max.

Cdg 
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Demo setup: 

Setup the Id-Vd Tracer Test setup for IRFP4004PbF by following the steps shown 

next and the numbers in figure 4-4. 

 

To setup the SMU resources: 

Step 1. Click "Sample setups" menu. Sample setup menu pops up. 

Step 2. Select "MOSFET" category  opens MOSFET tracer test definition menu. 

Step 3. Click "ID-VDS" setup. ID-VDS setup appears. 

Step 4. Make sure the SMUs are set as in the figure.  

If different, re-assign the Drain and the Gate SMU appropriately. 

Step 5. Change the VGS Mode from V to VPULSE Mode from the list by clicking the 

Mode list. Other parameters should be the same as the parameters shown in 

figure 4-4 (or the following table). 

 

● Setup parameters of SMUs: 

Set the SMU names, mode and function as follow. 

Unit V name I Name Mode Function

SMU2: MC VGS IG VPULSE VAR2

SMU3: UHC VDS ID VPULSE VAR1

Figure 4-4. Id-Vd Tracer Test setup of SMU resources. 

Demo 2-1-2.  
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To Setup X-Y scales: 

Follow the next steps and the numbers in figure 4-5. 

To set X axis: 

Step 1. Click on the maximum X scale value. 

Note: The focus area to detect your touch is very narrow. Click exactly on the 

character area to pop up the scale input box. 

Step 2. Horizontal Max. input box pops up. 

- Enter  60 V, then click X mark of the input box or press Enter key. 

  Note: Clicking other area cancels your input. 

- Horizontal max. scale is changed to 60 V. 

To set Y axis: 

Step 3. Click on the maximum Y scale value. 

Step 4. Vertical Max. input box pops up. 

- Enter  500 A, then click X mark of the input box or press Enter key. 

- Vertical max. scale is changed to 500 A. 

To set X-Y min. value: 

Repeat the same steps shown above for min. scale, too. 

5.

2.

4.

Expands 

VAR1 menu

Menu bar can be scrolled 

easily by dragging the no

mark filed (i.e. except           .)

b
a

1.

3.

X-Y Min.

c

d

e

Click exactly on the 

character to pop up the 

scale input box.

Current compliance is set for 

not exceeding the test fixture 

max. current limit.

Output V compliance is set for 

not exceeding the test device 

max. voltage limit.

Set Pulse Delay: 10 µs for 

Var1 for adjusting to the gate 

signal`s slower rise-up.

Set Pulse Width between 60 

µs ~ 100 µs..

Figure 4-5. Id-Vd Tracer Test setup of X-Y scales and 

VAR1 parameters. 
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To Setup VAR1: 

Step 5. Set VAR1 parameters: 

a. Click down arrow icon . 

VAR1 field expands. 

b. Set the following parameters: 

 

 

 

 

Tips: To scroll the measurement parameter input field: 

c. By focusing (pointing) the parameter input field, "Drag to scroll" sign appears 

(see #d). 

e. By dragging the bar, the mouse cursor changed to "hand " mark, and you can 

scroll the bar, and can see hidden part of the bar. 

 

To Setup Var2  

Follow the next steps and the numbers in figure 4-6. 

Step 6. Set VAR2 parameters 

f. Click down arrow icon . 

VAR2 field expands. 

g. Set the following parameters: 

Note: 

- Scroll up the Menu bar by dragging the bar as illustrated in figure 4-5. 

- For VAR2 START: Enter the Vth value measured in lab 1. 

Round up Vth in 0.5 V units. For example, if Vth = 3.1 V, enter 3.5 V. 

- For VAR2 STOP, add 2.5 V to the START V, so as the STEP V becomes to 500 

mV. 

 

Mode Start Stop NOS Interlacing Compliance Pwr comp
Output V

Comp

LIN-SGL 0 V 5 V 21 1 501 A OFF 39 V

Pulse

Base

Pulse

Delay

Pulse

Width

Dual

Polarity
Hold Time

0 V 10 us 100 us OFF 0 s

Start Stop NOS Compliance Pwr comp
Pulse

Base

Pulse

Delay

Pulse

Width
Hold Time

3.5 V 6 V 6 100 mA OFF 0 V 0 s 120 us 0 s
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Chapter 4. Demo 2-1: Id-Vd Tracer Test 

To Setup Meas. Time and Pulse Period: 

Step 7. Set Meas. Time (Integ Time) and Pulse Period: 

h. Set following parameters. 

 

 

 

 

 

Step 8. Save the test setup as a unique name, say "ID-VD Pulse G", means Id-Vd 

measurement with gate pulse. 

g

7.

6.

h

Expands 

VAR1 menu

f

- For VAR2 START: 

Enter the Vth value measured in lab 1.

Round up Vth in 0.5 V unit.  For 

example, if Vth = 3.1 V, enter 3.5 V.

- For VAR2 STOP, add 2.5 V to the 

START V, so as the STEP V becomes 

to 500 mV.

8.

Set  Gate Pulse width 20~50 

us longer than Drain pulse 

width.

Meas.

Time

Pulse

Period

10u~50us AUTO

Figure 4-6. Id-Vd Tracer Test setup of VAR2 AND Meas. 

Time parameters. 



60  

Chapter 4. Demo 2-1: Id-Vd Tracer Test 

To Start Id-Vd Repeat Measurement: 

Follow the next steps by following the numbers of figure 4-7 to start repeat meas-

urement. 

�Step 1. Close the test fixture cover before starting a test. This is especially impor-

tant for protecting any hazard from high current and high voltage.  

Step 2. Click Repeat Measure button.  

Step 3. Repeat measurement starts. 

Step 4. Highlight the VAR1 Stop entry field and leave it in active status. 

Step 5. Rotate the rotary knob to the right to increase the VAR1 sweep voltage. 

How is the trace changed? 

Step 6. The Id-Vd real time sweep trace appears as shown in figure 4-7. 

2.

3.

4.

1.

Close the lid of the 

test fixture

5.

6.

Figure 4-7. Id-Vd Tracer Test repeat measurement. 

Demo 2-1-3.  



61  

Chapter 4. Demo 2-1: Id-Vd Tracer Test 

To perform interactive Sweep: 

Follow the next steps to perform the Id-Vd interactive sweep. 

Step 1. The measurement is progressed in mid way, at the stop V is 30 V. 

- The output V compliance is set at 39 V, and the maximum sweep point is 

limited to one extra measurement step over this voltage. 

- The final sweep points of VAR1 for each VAR2 sweep step are limited to 

the maximum load line determined by the output resistance of UHCU and 

30 V output voltages. 

Step 2. This figure shows the Id- �Vd curve at VD is increased to 45 V. Maximum 

sweep voltage for VAR2 step 1 is limited at about 40 V by output V compli-

ance. 

�Step 3. Now VD is increased to 50 V. You can see near-breakdown curve in VAR2 

step 2 and 3. 

Step 4. This is the measurement at VD stop V is 60 V, the maximum power of 

UHCU. 

Step 5. Note the VAR2 step 1 sweep is stopped at around 40 V of the maximum VD 

specification of the MOSFET. 

If there is no output V compliance functionality, the MOSFET will be dam-

aged. 

Step 6. Another note is that load line at Vd=60 V exceeds the MOSFET 100 µs SOA 

limit at Tc=25 °C. 

If you continue the measurement at this level, the MOSFET will be dam-

aged permanently soon. 

Do not attempt to leave the measurement in this level for more than a few 

seconds, or avoid doing this level of measurement. 

Try the measurement adding by 3.5 kW power compliance instead of per-

forming this measurement. 

The measurement with power compliance follows in next part. 

1. VD=30 V

2. VD=45 V

3. VD=50 V

4. VD=60 V

Output V 

Compliance

Output V 

Compliance

SMU power 

amp output V

Load line of Output 

R = 120 mΩ @ 500 A 

range.

Because of the 

Output V Compliance, 

Id can be increased 

w/o exceeding the 

max. Vd limit.

Max. rating 

of the Vd

Var2 step1

Var2 step2

Var2 step5

Var2 step4

Var2 step3

Var2 

step6

SOA @100 µs line

3

5

4

1

2

6

Near-

breakdown

Figure 4-8. Id-Vd Interac-

tive Sweep. 
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Note: This test at 1,500 A range may damage the device in high possi-

bility. 

◆ To prevent the device damage: 

● Keep the max. STOP V to 30 V!   

Note: The data with 40V Stop V is for reference only! 

 

Using 1,500 A Range: 

If the drain UHCU current compliance exceeds 500 A, say 501 A, then the current 

range changes to 1,500A range. 

The output resistance of the UHCU changes to 40 mΩ, and the maximum allow-

able current increases three times compared to 500 A range. 

 

The red line of figure 4-9 shows the safe operating area (SOA) in the operation 

at 100 µs pulse width. 

As you can see some portion of the Id-Vd curve exceeds the SOA. 

Please keep the maximum Stop V to 30 V for not destroying the demo device. 

 

Following page shows an example that the device is damaged by exceeding SOA 

limit. 

1. VD=30 V

Output V 

Compliance

Max. rating 

of the Vd

Load line of Output R 

= 40 mΩ @ 1500 A 

range at Stop V=40 V.

501 A current 

compliance limit

SOA 100 µs line

Maybe PW < 30 µs would be 

necessary for protecting the 

DUT at Vd=40 V.

Do Not 

Exceed 30 V.

Exceeding 500A I 

compliance 

changes to 1,500A 

range.

30 V 40 V

Figure 4-9. Id-Vd Interac-

tive Sweep. 
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An example of a device damaging trace using Replay Traces function: 

You can record the measurement traces, and recall them by using Replay Traces 

function. 

Figure 4-10 is an example of the Replay Traces which was recorded the moment of 

the IRFP4004PgF MOSFET was damaged by applying too high power as shown in 

previous page. 

To use Replay Traces: 

Follow the next steps to use Replay Traces function after the sweep stops. 

Step 1. Clicking Replay Traces icon. 

Step 2. The Replay Traces window opens. 

Step 3. By moving the slide bar, you can recall the recorded traces. 

You can save the record to your file and recall it later if you save the record. 

The following explains the traces that the device is damaged. (Example only.) 

Step 4. The trace shows the sweep when the device is broken at  VD=38.7 V and 

ID=365 A. (See marker data) 

Note: that you can use the marker function even in the replay traces. 

Note: The power at the device failure was 38.7 V x 365 A = 14 kW that was 

way high of the 3.5 kW allowed in 100 µs pulse. 

Step 5. Probably the junction is damaged by the heat, and the device is shorted.  

The current and the voltage of this point is at 1,200 A and 5.3 V. 

The current compliance can not limit the current because the breakdown 

speed is so fast! 

Step 6. The next sweep traces are shown. 

It is obviously that the MOSFET is damaged in short mode failure.  

Probably it is short mode failure. 

Replay Traces

3

5

4

1

2
6

Figure 4-10. Example of Replay Traces of capturing the device damaged moment. 

Demo 2-1-4.  
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To Set Power Compliance: 3.5 kW  

In the previous page, an example of the device damage that the MOSFET was de-

stroyed because too high power was applied even in the pulsed measurement. 

If you set a proper Power compliance in the measurement setup, you can avoid ex-

ceeding the SOA limit and possibly preventing the damage of the device. 

Figure 4-11 shows an example to set power compliance and measurement curve 

with 3,500 W power compliance. 

As you can see, the SOA area of 100 µs pulse overlaps to the 3.5 kW power limited 

measurement curve and it is also limited inside of the 40 mΩ load line. 

 

◆ How to set Power compliance: 

   - Set Pwr Comp. in VAR1 parameter field as shown in figure 4-11. 

 

 

The effect of Current Compliance, Power Compliance and the V Compliance: 

Figure 4-11 shows three compliance setting; the Current Compliance, the Power 

Compliance and the V Compliance. 

● Output V Compliance: 

You can measure devices at high current and low voltage, but you also have to 

take into consideration the maximum voltage limit in the low current measure-

ment region because higher voltage is applied due to the smaller voltage drop at 

the output resistor. Output V Compliance can limit the high voltage in low current 

region. 

● Current Compliance: 

The current compliance ensures that you do not exceed the maximum current 

rating of the device. 

1. VD=30 V

Output V 

Compliance

Max. rating 

of the Vd

501 A current 

compliance limit

(=SOA 100 µs line)

Power compliance 

is set to 3.5 kW

3.5 kW Power 

compliance

Figure 4-11. 3.5 kW Power compliance, Output V compliance and Current compliance. 

Demo 2-1-5.  
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The objective of the Oscilloscope View demo is to be able to use the oscilloscope 

View function and interpret the Oscilloscope View waveform to judge if the pulse 

set parameters are appropriate or not. 

If there are any issues found, preferably, to be able to take a corrective action is 

desirable. 

The following topics are covered: 

● How to set the Oscilloscope View 

● How to use the result from the Oscilloscope View 

 

 

Demo device and demo setup  

We use the same device and the setup of demo 2-1. Id-Vd test. 

 

 

What is Oscilloscope View 

EasyEXPERT (Rev. 5 and higher) supports an Oscilloscope View (refer to figure 4-12) 

on the B1505A that allows you to monitor pulse measurement waveforms with 2 µs 

resolution. 

It has the following features; 

● I/V curves and pulse waveforms are displayed simultaneously. 

● Waveform measurement pulses can be monitored at any point. 

● Both voltage and current can be read using the Marker line. 

● The pulse measurement conditions can be changed during measurement and 

the resultant waveforms can be verified on the fly. 

Large current signals applied to the drain/Collector can be distorted by parasitic 

components (such as the cable inductance of the test setup), and these parasitic 

components can lead to unexpected measurement results. 

The Oscilloscope View helps to prevent this by providing the exact waveform shapes 

as well as the relative positions of the drain and the gate signals. This allows you to 

adjust your timing parameters so as to achieve optimal measurement conditions.  

The Oscilloscope View reduces debugging time while also improving the quality of 

your measurement data. 

Demo 2-2 Id-Vd Tracer Test measurement using Oscilloscope View 

Objective: 

Demo 2-2-1.  

Demo 2-2-2.  
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How to set Oscilloscope View: 

Figure 4-12 shows an example of an Oscilloscope View for Id-Vd Tracer Test meas-

urement. 

You can monitor the waveform of the output voltage and current on the specified 

measurement point. 

In the pulsed measurement, it is very important to check the pulse waveform, pulse 

current and the relation of the measurement point in the pulsed signal to assure the 

measurement quality. 

 

����To monitor the pulse waveform: 

Step 1. Click the Oscilloscope View icon. 

Step 2. Oscilloscope view window opens. 

You can change most of the parameters by clicking on the Oscilloscope 

view parameters. 

Step 3. Sampling parameter selection and the parameter setup can be made 

through the view menu.  

Step 4. Marker field shows the time and the readout at the marker position. 

Step 5. The scales of each parameter are shown. 

 

The Oscilloscope View of figure 4-12 shows the VDS waveform of the 16th 

Var1 sweep point of the third Var2 step which is marked on the I/V curve  

Oscilloscope View3

1

2

4

5

Marker line

Figure 4-12. Pulsed Id-Vd: Oscilloscope View example. 

Demo 2-2-3.  
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◆ How to set the Oscilloscope View parameters: 

To set the Oscilloscope View, follow the next steps by following the number of 

figure 4-13. 

Step 1. Click Data menu. 

Step 2. Click a parameter to view on the oscilloscope. 

Step 3. The popup menu closes one at a time and the selected parameter is 

added on the marker view field. 

Repeat #2 & 3 action to set all the parameters to view. 

Step 4. Scale parameter also appears in this area. 

Step 5. The sampling point parameter can be set by clicking on the marker view 

field. 

Step 6. Time scale can be changed by clicking on the s/div field. 

Step 7. Time origin can be changed by clicking on the Time origin number. 

Step 8. If you click one of the parameter of #4 field or Setup menu, a vertical 

scale setting window pops up. 

Each parameter window displays, from the top, the vertical scale, the 

center reference level and the line color. 

These vertical scale parameters can be set by clicking on each parame-

ter. 

1.

4

3

1

2

8

7

6

5

Select one at a time

Figure 4-13. How to setup Oscilloscope View parameters. 
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◆How to use the Oscilloscope View or the waveform monitor.  

Figure 4-14 shows an example of how to use the Oscilloscope View. 

Follow the next steps and the numbers in figure 4-14 to display  the waveform. 

Step. 1. The oscilloscope view parameters are shown in #1. 

Step. 2. The data point to view is shown in #2, that is 27th Var1 sweep point of 

the 7th Var2 step. 

Step. 3. The data point is shown on the graph. (see #3) 

Step. 4. Var1 Pulse delay and width are 10 us and 80 us respectably. 

Step. 5. The oscilloscope view shows VDS, ID and VGS. 

Step. 6. The oscilloscope view can be enlarged as in the figure (see #5) 

a. Shows the trace color and the marker point value. 

b. The horizontal scale can be changed by clicking on the value. 

c. The horizontal center time can be changed by clicking on the value. 

d. Marker can be set by clicking on any point on the graph. 

e. The green line indicates the measurement time window. 

f. This area shows the amplitude and the offset (shift of the measure-

ment curve) of each parameter`s trace. 

5

3

0 us-30 us

Marker line

- Parameter color indication

- Marker read out

a.

b.

c.

d.

e.

f.
- Amplitude and 

Offset of each 

parameter

g.

6

2

1

h.

7

4

Figure 4-14. How to use the Oscilloscope View? 



69  

Chapter 4. Demo 2-2: Oscilloscope View 

g. Indicates the actual sampling start time (= Delay that is set in #2 

flame). 

h. Optional: 

If you change the Var2 step to "EACH", then the waveform monitor re-

freshes for each Var2 step for specified Var1 sweep point. 

Step. 7. You can save the Oscilloscope view data in both the text and graphic for-

mat. 

 

The setup data is saved in the test setup data. 

 

   Note: Unfortunately, there is no independent save -recall function. 
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Chapter 4. Demo 2-2: Oscilloscope View 

◆Tips: How to use the Oscilloscope view waveform to Var1 Pulse Delay setting 

Figure 4-15 shows an example use of the waveform to set Var1 pulse delay time. 

Follow the next steps and the numbers shown in figure 4-15. 

Step 1. The var1, drain pulse delay is changed from 10 us (of figure 4-14 setting) 

to 0 µs (no delay relative to the gate pulse because the gate pulse delay 

is set to 0 µs). 

The pulse width is the same. 

Step 2. The data point to view the waveform is shown on the graph. (see #2) 

Step 3. The enlarged Oscilloscope View is shown. 

Note: The size can be changed from the Oscilloscope view menu -> Win-

dow, or by dragging the window. 

Step 4. The drain voltage pulse (green) is faster than the gate pulse to hit Vth 

around the wave surrounded by a red circle. 

Because there flows relatively small current (an order of less than 100 A), 

there appears a smaller voltage drop between the UHCU output resistor, 

resulted in higher voltage applied to the drain. 

Step 5. The drain voltage is gradually decreases to the voltage that is determined 

by the load line of the UHCU output resistor, UHCU output voltage (45.5V) 

and the MOSFET impedance until an expected large drain current is set-

tled down. 

Step 6. Try changing the delay (maybe <20 µs), and check how the waveform 

changes. 

In this way, you can control the voltage to be applied to your device by controlling 

the pulse parameters. 

In this example, you can avoid unexpected large transient voltage is applied and 

damages your device. 

2

1

0 us-30 us

3

4
5

Figure 4-15. How to use the Oscilloscope View waveform? 

Demo 2-2-4.  



71  

Chapter 4. Demo 2-3: Rds ON characteristics 

The objective of Rds ON demo is to learn the followings; 

● UHCU can output current source, and Rds ON measurement typically uses current 

source to the drain. 

● Arithmetic operation function calculates the Rds in real time, and Rds can be dis-

played on the curve tracer display. 

Note: 

Applying a constant current is not possible using a traditional curve tracer, as 

it only has a voltage source mode. Previously, this measurement could only be 

performed using a very expensive production power device tester.  

However, the B1505A’s UHCU can easily perform this measurement. 

 

◆How to measure Rds ON characteristics: 

There are two methods to calculate the Rds as shown in figure 4-16. 

This demo extracts Rds ON resistance by using the calculation: Rds= Vds/Id (the 

first approach shown in figure 4-16). 

We use a new arithmetic operation function to calculate the Rds. 

Note:  

1. The second approach using delta function is not supported in the 

Tracer Test mode. 

2. The delta function can be used in Classic Test mode. 

You can convert the Tracer Test setup to a Classic Test definition eas-

ily.  For detail, refer to chapter 10. 

Demo 2-3 Rds ON Characteristics  

Demo 2-3-1 Rds ON Characteristics  (Rds On vs. Id) 

Demo 2-3-2 Rds ON Characteristics  (Rds On vs. Vg) 

Objective: 

Two methods to extract Rds_on:

• Rds = Vds/Id,  if R is linear vs. Id

or

• Rds = delta Vds/ delta Id, if R is non-linear vs. Id

Vd:

Var1

Vg:

Var2

SMU1: MCSMU

SMU2: UHCU
Expected Rds < 2 mΩ

Use 40 mΩ by set I comp> 501 A

IRFP4004PbF:

Rds(on) @ Id = 195 A, Vg=10 V

Typ. 1.34 mΩ, 

Max. 1.7 mΩ

Vd sweep condition:

• Suppose;

- Total R=50 mΩ 

- Max Id = 300 A

Vd max = 50 mΩ x 300 A
= 15 V

3

1

2

Figure 4-16. Rds ON characteristics. 
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Chapter 4. Demo 2-3: Rds ON characteristics 

◆ Demo device: 

WE use IRFP4004 PbF power MOSFET in this demonstration. 

The Rds(on) specification is shown in section 2-3 and 4. Demo 2-1,  

and it is maximum 1.7 mΩ at Vgs=10 V and Id=195 A. 

7

2
3

4

8

9

Manual sweep from 500 mV to >10 V

5

6

Click target to change.

1

10

Figure 4-17. Setup of Rds ON - Id test. 

Mode Start Stop NOS Interlacing Compliance Pwr comp
Output V

Comp

LIN-SGL 500 mV 10 V 21 1 501 A 3.5 kW 2 V

Pulse

Base

Pulse

Delay

Pulse

Width

Dual

Polarity
Hold Time

0 V 0 s 100 us OFF 0 s

Demo 2-3-1. Rds ON Characteristics (Rds On vs. Id) 

◆ Rds ON vs. Id (Rds_on - Id) Tracer Test setup and measurement 

To Measure Rds on vs. Id characteristics, we use V force sweep measurement to 

the drain source. Since UHCU has built in output resistor, the actual voltage and the 

drain current is determined by the on resistance of the MOSFET. 

 

Follow the next instructions to setup the test by following the numbers of figure 4-

17. 

Step 1. The "Sample setups" menu uses MOSFET -> Id-Vds. 

Step 2. Set VAR1 parameters as shown in figure 4-17, or in the following VAR1 list. 
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Chapter 4. Demo 2-3: Rds ON characteristics 

Step 3. Set VAR2 parameters as shown in figure 4-17, or in the following VAR2 list: 

 

 

 

Step 4. Set Meas. parameters: 

- Meas. Time to 50 us. 

Step 5. Click Tool bar menu -> Option -> Arithmetic Operation -> Operation 1. 

Arithmetic Operation 1 appears. 

Step 6. Set the following equation: 

RDSon [ohm] = VDS / ID 

Click target to edit the name or change operation. 

Step 7. Change Y-axis to RDSon, and X-axis to ID. 

Step 8. Change Y axis max. to 2m (ohm). 

Step 9. Change X-axis max. to 250 A. 

Step 10. Change Setup Name to "RDS0n ID-VGS". 

Step 11. Start measurements by pressing single measure button, or sweep manually. 

The measurement curve similar to figure 4-18 should be obtained. 

 

After the measurement, follow the next steps in figure 4-18 to extract Rds. 

Step 1. Click Marker. 

Step 2. Marker  appears on the measurement start position and the marker data is 

shown. 

Step 3. Move the marker to around Id = 195 A. 

Step 4. Rds(on) can be read from the marker readout. 

Note: You can read closer to target 195 A if you set more measurement 

points by increasing the VAR1 steps. 

Start Stop NOS Compliance Pwr comp

10 V 10 V 1 100 mA OFF

Figure 4-18. Rds_on vs. Id characteristics.  

1

2

Marker readings:

• Rds(on) = 1.65 mohm

@ Id= 195 A

3



74  

Chapter 4. Demo 2-3: Rds ON characteristics 

Note: (see #4) 

Start V should be not zero volts because theoretically the resistor becomes 

infinity since R=V/I, where I=0 A at V=0 V. 

 

Also, considering the offset voltage and the offset current of the SMU, it is 

desirable to set the start voltage as like 1/10th of the stop voltage to minimize 

the measurement error to a negligible level. 

 

Review: 

● The measured ON resistance is 1.65 mΩ and it is within the maximum specifica-

tion limit; 1.7 mΩ. 

 

● Try another measurement by changing the insertion height of the MOSFET to 

the fixture socket. 

If you insert the leads deeper, then the resistor should show lower resistance 

because the measurement includes the leads resistance of the drain and the 

source terminal. 

 

Note: The fixture socket uses Kelvin connection, and the effect of contact re-

sistance between the fixture socket and the MOSFET leads should be 

minimal. 
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Chapter 4. Demo 2-3: Rds ON characteristics 

The datasheet of power MOSFET typically expresses Rds ON characteristics by Rds 

ON versus Vg. 

This section demonstrates this test approach. 

 

◆ Rds ON vs. Id (Rds_0N - Vg) Tracer Test setup and measurement 

To Measure Rds on vs. Vg characteristics, we use I force mode to the drain and 

sweeps the gate. Since UHCU can force current, this measurement can be done 

quite easily. 

 

Follow the next instructions to setup the test by following the numbers of figure 4-

19. 

Step 1. The "Sample setups" menu uses MOSFET -> Id-Vgs. 

Step 2. Set VAR1 parameters as shown in figure 4-19, or in the following VAR1 list. 

Demo 2-3-2. Rds ON Characteristics (Rds On vs. Vg) 

7

2
3

4

8

5

6

Click target to change.

1

9

Figure 4-19. Setup of Rds ON - VGS test. 

Mode Start Stop NOS Interlacing Compliance Pwr comp
Output V

Comp

LIN-SGL 0 V 10 V 51 1 100 mA OFF OFF
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Chapter 4. Demo 2-3: Rds ON characteristics 

Step 3. Set VAR2 parameters as shown in figure 4-19, or in the following VAR2 list: 

 

 

 

 

 

 

 

 

Step 4. Set Meas. parameters:  

- Meas. Time to 500 us. 

Step 5. Click Tool bar menu -> Option -> Arithmetic Operation -> Operation 1. 

Arithmetic Operation 1 appears. 

Step 6. Set the following equation:  

Rd [ohm] = VDS / ID 

Click target to edit the name or change operation. 

Step 7. Change Y-axis to Rd. 

Step 8. Change Y axis max. to 10 m (ohm). 

Step 9. Change Setup Name to Rd-VGS. 

Step 10. Start measurements by pressing single measure button, or sweep manually. 

The measurement curve similar to figure 4-20 should be obtained. 

Figure 4-20. Rd-VGS characteristics.  

Start Stop NOS Compliance Pwr comp
V

Compliance

50 A 200 A 4 30 V OFF OFF 

Pulse

base

Pulse

Delay

Pulse

Width
Hold Time

0 A 0 s 1 ms 0 s

Id=200 A

Id=150 A

Id=100 A

Id= 50 A

Marker

Arithmetic operation

1

2

Marker readings:

• Rds(on) = 1.625 mΩ

@ Id= 50 A ~ 200 A

3
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Chapter 4. Demo 2-3: Rds ON characteristics 

After the measurement, follow the next steps to extract Rds. 

Step 1. Click Marker. 

Step 2. Marker  appears on the measurement start position and the marker data is 

shown. 

Step 3. Move the marker to VGS=10 V. 

Step 4. Rd on can be read from the marker readout: 1.625 mΩ.  

The Rds on value is almost the same at Vg=10 V for four Id current at 50, 

100 , 150 and 200 A in the example. 

 

 

 

Review: 

● The Rd-Vg graph indicates that the MOSFET becomes turn on around Vg=5.5 

~ 6 V depending on the drain current. 

● Then Rd on converges to about 1.6 mΩ when Vg increases to 10 V. 

 

The measured results agree to the results from the demo 2-3-1 and the data-

sheet specification. 
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Chapter 4. Demo 2-4: Ic-Vc Tracer Test (IGBT) 

To learn that IGBT test is the same as the power MOSFET demo shown in demo 2-1. 

Check section 4-4 Demo 2-1 for detail.  

 

Before the demo: 

Make sure the cable connection between the test module and the B1505A, EasyEX-

PERT configuration setup.  

 

◆To set demo device  

Set the demo IGBT to the fixture as shown in the next figure. 

 

 

 

 

 

 

 

 

 

Following shows brief information of SOA area, capacitance information and the 

saturation characteristics of the device. Refer to section 2-3 for the device specifi-

cations. 

Demo 2-4 IGBT Ic-Vc measurement using the Tracer Test 

Objective: 

G  C  E

G   C   E

Device

FGA180N33ATD  

IGBT 

0

1000

2000

3000

4000

5000

6000

1 10

C
a

p
a

c
it

a
n

c
e

 
(p

F
)

Vce (V)

Capacitance vs. Vce

Ciss

Crss

Coss

30

0.1 

1.0 

10.0 

100.0 

1,000.0 

1 10 100 1000

Ic
e
  
(A

)

Vce (V)

Maximum Safe Operating Area

Notes:

Tc=25 °C

Tj=150 °C

Single Pulse

100 µsec

1 msec

10 µsec

0

4

8

12

16

20

0 4 8 12 16 20

V
d
e
 (

V
)

Vge (V)

Saturation Voltage vs. Vge

180 A

40 A

Common Emitter

Tc=25 °C
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Chapter 4. Demo 2-4: Ic-Vc Tracer Test (IGBT) 

Demo setup: 

The setup of the Ic-Vc Tracer Test setup for FGA180N33ATD IGBT is almost the 

same as HC power MOSFET in demo 2-1. 

Basically refer to demo 2-1 except for the unique portion regarding the IGBT setup 

shown next. 

 

◆ To setup the SMU resources: 

Step 1. Click "Sample setups" menu. Sample setup menu pops up. 

Step 2. Select "IGBT" category  opens IGBT tracer test definition menu. 

Step 3. Click "IC-VCE" setup. IC-VCE setup appears. 

Step 4. Make sure the SMUs are set as in the figure.  

If different, re-assign the Drain and the Gate SMU appropriately. 

Step 5. Change the VGE Mode from V to VPULSE Mode from the list by clicking 

the Mode list. Other parameters should be the same as the parameters 

shown in the next figure. 

 

◆ To Setup X-Y scales: 

Follow Figure 4-5 of demo 2-1 to setup the X-Y graph. 

 

◆ To Setup VAR1 and VAR2 parameters: 

Setup VAR1, VAR 2 and Meas. Time parameters as same as the following tables. 

1.

3.2.

IC-VCE setup example

4.

5.

VAR1

Mode Start Stop NOS Interlacing Compliance Pwr comp
Output V

Comp

LIN-SGL 0 V 5 V 21 1 501 A 7 kW OFF

Pulse

Base

Pulse

Delay

Pulse

Width

Dual

Polarity
Hold Time

0 V 20 us 80 us OFF 0 s
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Chapter 4. Demo 2-4: Ic-Vc Tracer Test (IGBT) 

 

 

 

Note: 

For VAR2 Start and Stop voltage, adjust them while in measurement depending 

on the Vth of the demo IGBT. 

 

 

Measurement and the result: 

1. Click Single Measure button. 

2. After the  measurement, you are expected to obtain the output as shown in figure 

4-21. 

 

◆ Review: 

1. There is no need to set V Compliance because the breakdown voltage if the 

demo IGBT is 330 V, and it is much higher than the maximum voltage of UHCU 

(= 60 V). 

2. The SOA of the demo IGBT is about 7 kW at 100 µs width pulsed collector cur-

rent, and you can demonstrate more power range of UHCU compared to the 

RFP4004 MOSFET.  

VAR2

Start Stop NOS Compliance Pwr comp
Pulse

Base

Pulse

Delay

Pulse

Width
Hold Time

6 V 11.5 V 7 200 mA OFF 0 V 0 s 150 us 0 s

Meas.

Delay

Meas.

Time

Pulse

Period

AUTO 6 us AUTO

Figure 4-21. IC-VCE characteristics.  

40 mΩ Load-line (@VC=50 V)
7 kW Power-line

120 mΩ Load-line (@VC=60 V)
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Chapter 4. Demo 2-5: Vce(sat) characteristics (IGBT) 

The objective of Vce(sat) demo is to learn the followings; 

● UHCU can output current source, and Vce(sat) measurement typically uses cur-

rent source to the collector. 

● The B1505A can easily measure Vce(sat) parameter. 

Note: 

Applying a constant current is not possible using a traditional curve tracer, as 

it only has a voltage source mode. Previously, this measurement could only be 

performed using a very expensive production power device tester.  

However, the B1505A’s UHCU can easily perform this measurement. 

 

◆How to measure Vce(sat) characteristics: 

A constant current is applied while the gate is swept.  

Since there is a built-in output resistor in the output of UHCU, the maximum volt-

age compliance value is desirable to obtain before the measurement. 

Figure 4-16 shows such an example calculation. 

 

We use a 500 A range to force a constant current, and the output resistance of 

UHCU is 120 mΩ in that case. 

The right bottom column of figure 4-16 shows the maximum voltage requirement for 

UHCU is 32 V to force around 250A with a little margin to the 180A specification con-

dition of the collector current. 

Demo 2-5 Vce(sat) Characteristics  

Objective: 

I Force

Ic-Vc measurements
Time

V or I

Ic force

Vg

Measure Vc

Measurement condition:

- @ Ic=40 A, Vge=15 V  Vce-sat max.=1.4V

- @ Ic=180A, Vge=15 V  Vce-sat typ.=1.68 V

Ic SMU meas. condition: Vc comp

- Vc: 2 V min.

- Rc: 120 mΩ 

- I max sweep: 250 A (>180 A)

Vc comp = 2 V + 0.12 Ω x 250 A

>= 32 V

Rc: 120 mΩ 

@500 A range

MCSMU

UHCU

GNDU

Figure 4-16. Rds ON characteristics. 
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Chapter 4. Demo 2-5: Vce(sat) characteristics (IGBT) 

◆ Vce(sat) Tracer Test setup and measurement 

Follow the next steps and the numbers shown in figure. 

Step 1. Select Sample Setups -> IGBT -> IC-VGE. 

Step 2. Change SMU3:UHC Mode: from "VPULSE" to "IPULSE". 

Step 3. Set VAR1 parameters as shown in figure 4-17, or in the following VAR1 list. 

 

 

 

Step 4. Set VAR2 parameters as shown in figure 4-17, or in the following VAR2 list. 

 

◆ Demo device: 

WE use FGA180N33ATD IGBT in this demonstration. 

The Vce(sat) specification is shown in section 2-3 and 4. Demo 2-4,  

as, VCE(sat): Typ. 1.68 V @ Ic=180A. 

Demo 2-5. Rds ON Characteristics (Rds On vs. Id) 

6

1c.

1b.

1

9

43

5

2

8

7

10

Figure 4-17. Vce(sat) setup. 

Mode Start Stop NOS Interlacing Compliance Pwr comp
Output V

Comp

LIN-SGL 0 V 10 V 51 1 100 mA OFF OFF

Start Stop NOS Compliance Pwr comp
V

Compliance

40 A 180 A 3 60 V OFF OFF 

Pulse

base

Pulse

Delay

Pulse

Width
Hold Time

0 A 0 s 200 us 0 s
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Chapter 4. Demo 2-5: Vce(sat) characteristics (IGBT) 

Step 5. Set Meas. Time to 100 us. 

Step 6. Change the Y axis display parameter from IC -> VCE. 

Step 7,8. Change axis max. scale to 20 V for both X and Y. 

Step 9. Click repeat measurement button. 

Step 10. Click Var1 stop value to activate the parameter change. 

Gradually increase the gate voltage to 20V. 

The Vce-sat curve can be obtained as shown in figure 4-18. 

 

◆ To Analyze Vce-sat voltage: 

Step 11. Click Marker button. The marker appears on the sweep start point. 

Step 12. Move the marker to the 15 V on the top line (VAR2=180 A) that is the 

Vce-sat measurement condition of this IGBT. 

Step 13. Read the Vce-sat. 

It is about 1.736 V in the example, and very close to the typical value at 

IC=180 A (1.68 V). 

 

Review: 

The Vce(sat) graph indicates that the saturation voltage becomes lower when 

the gate voltage becomes higher even the gate voltage exceeds the specified 15 

V. 

     Note: The specification of the max. Vge is 30 V. 

 

The measured curve agrees to the data sheet curve shown in the beginning of 

the section: Demo 2-4. 

Figure 4-18. Vce(sat) analysis. 

3.

4.

2.

Marker

11

13

12
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Chapter 4. Demo 2 

In the demo 2, following topics are covered: 

Demo 2-1: Id-Vd Tracer Test 

● Id-Vd Tracer Test with High Current MOSFET. 

● How to set the wire and the device on the test fixture. 

● How to configure the UHCU in EasyEXPERT configuration window. 

● How to setup the Tracer Test using the sample menu. 

● How to execute the interactive Tracer Test mode sweep. 

● How to use the three Compliance mode: 

- Current compliance 

- Voltage compliance 

- Power compliance 

● How to use the Replay Traces function. 

Demo 2-2. Oscilloscope View: 

● How to set and how to use the Oscilloscope View. 

● Simultaneous four channel waveform monitor for both the voltage and current 

waveform is very unique, and available only on for the B1505A in curve tracer 

mode. 

Demo 2-3. Rds ON characteristics, and Demo 2-5 Vce(sat) characteristics: 

● These measurements using a current source mode are only possible with the 

B1505A. 

● The maximum current in the demo was around 200 ~ 300 A, but it can be ex-

panded to more than 1000 A if a customer prepares such a device and the test 

socket. 

Demo 2-4. Ic-Vc Tracer Test (IGBT): 

● The demo showed that the measurement is almost the same as power MOS-

FET except choosing the test setup example from the IGBT sample menu. 

● IGBT module in the market is a good target of the 1500 A UHCU, and it can be 

connected by using a test leads with a washer plug of the N1265A. 

Summary of Demo 2 
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Chapter 5. Demo 3: Id-Vg and Ic-Vg measurement 

5-1. Demo setup and what are the transfer characteristics 

5-Demo 3-1. Id-Vg Transfer Characteristics (Application Test) 

5-Demo 3-2. Ic-Vg Transfer Characteristics (Application Test) 

 

This chapter covers the following test. 

1. Id-Vg Application Test (HC MOSFET) 

2. Ic-Vg Application Test (IGBT) 

 

The objective of this chapter is to perform the above test and understand 

B1505A`s test sequence programming capabilities by using the Application Test 

mode. 

 

● Id-Vg or Ic-Vg measurement requires constant voltage source in drain or collector 

supply.  

But it is difficult under the curve tracer mode (UHCU) because there is a voltage 

drop by the output resistor of the power supply. The voltage drop by the resistor 

is unknown because the current flowing to the resistor cannot be determined 

before the measurement. 

● The EasyEXPERT application test definition furnished with the B1505A solves this 

problem by using the programming capability of the Application Test mode. 

 

Demo 3 uses the following devices; 

● IPFP4004 PbF HC MOSFET 

● FGA180N33ATD IGBT 

Use the same setup of section 3-1 and figure 3-1. 

 

Use the same configuration of section 4-2 or demo 2. 

Chapter 5. Demonstration 3: Id-Vgs & Ic-Vge Transfer Characteristics 

Ultra High-Current Measurement using UHCU with Application Test mode 

Contents: 

Objective: 

Features: 

Device used: 

Wiring and Device setting inside of the N1265A Fixture 

EasyEXPERT Configuration for Expanders 
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Chapter 5. Demo 3: Id-Vg and Ic-Vg measurement 

Figure 5-1 shows the basic measurement block diagram and the measurement result 

of Id-Vgs measurement using UHCU. 

Id-Vgs at fixed Vd is an important test so as you can check the gain of the power 

MOSFET (Transfer characteristics from the gate voltage to the drain current). 

Demo 3 shows that you can make Id-Vgs test with a fixed Vd by using a sample ap-

plication test definition. 

The basic idea hidden under the "Id-Vgs for Expanders)" application test is ex-

plained next. (You can skip the explanation, though.) 

 

Follow the next step numbers by following the same number in figure 5-1 to under-

stand the explanation: 

Step 1. Unfortunately, there is a series output resistor in the UHCU output, and you 

cannot generate a constant voltage at the UHCU output if there is unknown 

collector current.  This is because there is a voltage drop in the output re-

sistor Rd of UHCU. 

Step 2. The Id-Vgs curve is equivalent of the re-plot points of (continues to step 3) 

Step 3. the sampling points at Vds of the Id-Vds measurement curve. 

Step 4. The UHCU output voltage is actually applied to the collector by following 

the load line determined by Rd, UHCU set V and IGBT output impedance. 

5-1. How the Id-Vg transfer characteristics  measurement is done?    

Vd pulse (constant)

Rd:40 mΩ @1500 A range 

(Id comp>501 A)

120 mΩ @500 A range

(Id comp<=500 A)

Vg

UHCU

MCSMU

GNDU

Var1:

Time

Voltage

Vd

Vg

Measure Id

Id

Vds
Sweep 1 Sweep 2 Sweep 3

Vg-1

Vg-4

Vg-3

Vg-2

Id

Vg

1

5

2

4

3

Load line by Rd at Sweep 1 start V
V drop by Rd

Re-plot of the

Id-Vds sampling 

at Vds is 

constant V.

6 7

8

Figure 5-1. The internal operation of Id-Vg Applica-

tion Test for Expanders. 
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Chapter 5. Demo 3: Id-Vg and Ic-Vg measurement 

Step 5. The voltage set to the UHCU is different at the collector pin by the voltage 

dropped through Rd. 

Step 6. You can extract the Id at the target Vds by searching the Id at constant Vds 

from the Id-Vds measurement curve at arbitral Vg step. 

Step 7. By repeating the Id-Vgs sweep for different Vg as shown in figure 5-1, the 

accurate Id-Vgs measurements can be made easily, though it takes a little 

bit more time than directory measuring Id-Vg test with SMUs. 

Step 8. The B1505A provides EasyEXPERT application test by using this approach. 
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Chapter 5. Demo 3: Id-Vg and Ic-Vg measurement 

● To understand Id-Vg Transfer characteristics with constant Vd can be per-

formed even there is an output resistor in the power supply. 

● To experience that you can add analysis on the data display (output data) win-

dow. 

Demo device  

Set IRFP4004PbF to the 3 pin in-line Socket as shown in the next figure. 

Demo 3-1: Id-Vgs Transfer Characteristics 

Objective: 

G   D   S

G   C   E

G: Gate

D: Drain

S: Source

C: Collector

E: Emitter

Device

G    D    S

IRFP4004 

HC MOS 

Demo 3-1-1.  

Demo 3-1-2.  Demo setup: 

Setup the Id-Vg Application Test for IRFP4004PbF by following the steps shown next 

and the numbers in figure 5-2. 

Step 1. Click Application Test Tabs. 

Step 2. Check IGBT and PowerMOSFET Category 

Step 3. Enter "Ex" in the search field. 

Only the application test definition with "ex" will show up in the Library 

field. 

Step 4. Click and select "Id-Vgs for Expanders". 

The application test GUI shows up. 

IGBT & PowerMOSFET

Category2

1

3

4

Filter by "Ex"

Figure 5-2. Id-Vgs 

Application Test. 
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Chapter 5. Demo 3: Id-Vg and Ic-Vg measurement 

Test parameter setup: 

Follow the next instructions to setup the test by following the numbers of figure 5-3. 

Step 1. Enter the test parameters listed in the next tables by referring to the input 

locations shown in figure 5-3.  

 

 

 

 

Step 2. Click Extended Setup 

Extended Setup window opens. 

Demo 3-1-3.  

Figure 5-3. Id-Vg Application Test parameters. 

SO

By setting Debug: On,

you can monitor the 

intermediate Id-Vd search 

sweep.

51

2

3

4

Device Parameters:

Polariy Y1AxisIdMin Y1AxisIdMax Y2AxixGfsMin Y2AxixGfsMax

Nch 0 A 500 A 0 S 500 S

Test Parameters: Gate SMU2:MC

VgsStart VgsStop VgsStep IgLimit VgsBase VgsWidth VgsDelay

3V 8 V 200 mV 1A 0 V 100 us 0 s

Test Parameters: Drain SMU3: UHC

Vds IdLimit VdsBase VdsWidth VdsDelay
Pulse P

Mode

Man P

Period

Meas

Time

Pulse Ave

Count

10 V 501 A 0 V 70 us 10 us AUTO 100 ms 10 us 1
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Chapter 5. Demo 3: Id-Vg and Ic-Vg measurement 

Step 2. Click Extended Setup 

Extended Setup window opens. 

Step 3. Enter the following parameters. 

Leave the other parameters as is. 

 

 

 

 

Step 4. Note 

By setting the Debug field to "On", you can monitor the intermediate Id-Vd 

search sweep measurement. Refer to figure 5-1 step number 6 to 7. 

Step 5. Click single measure button. 

Display Data window opens, and the measurement starts. 

 

Note: Since there is one or more search sweep runs between one Id-Vg 

spot measurements, it takes for a while until the entire Id-Vg sweep is fin-

ished. 

 

Finally, the Id-Vg and Gfs curve is measured as shown in figure 5-4. 

Step 6. Click Marker icon. 

Marker shows up at the first measurement point. 

Step 7. Move the marker to an appropriate data point. 

For example, click Y2 axis, and then "Marker Maximum" icon will jump the 

marker to Gfs maximum position. 

Step 8. Marker data from the left, X value, Y1 value and Y2 value can be read. 

 

VsrchLimit Debug

40 V Off

7

6

8

Figure 5-4. Id-Vgs for Expanders  Application Test result. 



91  

Chapter 5. Demo 3: Id-Vg and Ic-Vg measurement 

◆ Post Analysis: 

You can add post analysis on the Data Display window. 

In this section, let`s try adding Log Id curve in Y2 axis. 

 

● To add different scale parameter: 

Follow the next steps by referring to the numbers in figure 5-5. 

Step 1. Click View menu. 

Step 2. Click Display setup. 

Step 3. Display setup window opens. 

Step 4. Add different parameter; Example ID in log scale, Min.= 1 A, Max.= 1 kA. 

Step 5. Click OK will add new Log ID parameter in the graph display (Y3 axis 

shown in green line). 

You can toggle Y2, Y3 by clicking right side Y axis. 

Step 6. You can add legend of the line. 

Step 7. You can see the test condition that VDS is a constant 10 V in the List Dis-

play. 

Step 8. Clicking Y2 axis toggles the Y2 axis between Y2 and Y3 

2.

3.

4.

1.

5.

6.

7.

Figure 5-5. Post analysis on Data Display window. 

8. 
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Chapter 5. Demo 3: Id-Vg and Ic-Vg measurement 

Demo device  

Set FGA180N33ATD IGBT to the 3 pin in-line Socket as shown in the next figure. 

Demo 3-2: Ic-Vge Transfer Characteristics 

Demo 3-2-1.  

G  C  E

FGA180N33ATD 

IGBT 

G   C   E

Device

Demo 3-2-2.  Demo setup: 

Follow the same instruction of Demo 3-1-1. 

In the step 4, click and select "Ic-Vge for Expanders". to set the application test GUI. 

 

Test parameter setup: 

The steps to enter the test parameter is enactory the same as the power MOSFET in 

section Demo 3-2-3. 

Step 1. Enter the test parameters listed in the next tables.  

 

 

 

 

Step 2. Click single measure button. 

Display Data window opens, and the measurement starts. 

 

The results shown in figure 5-6 is obtained. 

 

Demo 3-2-3.  

Device Parameters:

Polariy Y1AxisIdMin Y1AxisIdMax Y2AxixGfsMin Y2AxixGfsMax

Nch 0 A 500 A 0 S 100 S

Test Parameters: Gate SMU2:MC

VgeStart VgeStop VgeStep IgLimit VgsBase VgeWidth VgeDelay

4V 10 V 250 mV 1A 0 V 100 us 0 s

Test Parameters: Drain SMU3: UHC

Vce IcLimit VceBase VceWidth VceDelay
Pulse P

Mode

Man P

Period

Meas

Time

Pulse Ave

Count

20 V 501 A 0 V 70 us 10 us AUTO 100 ms 10 us 1

Extended Parameters:

VsrchLimit Debug

60 V Off
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Chapter 5. Demo 3: Id-Vg and Ic-Vg measurement 

◆ Post Analysis: 

To display markers on the peak of the Gfs, follow the next steps by referring to the 

numbers of figure 5-6. 

Step 3. Click Marker icon. 

Marker shows up at the first measurement point. 

Step 4. Click Y2 axis. 

The focus to control the graphics analysis moves to Y2 axis. 

Step 5. Click "Marker Maximum" icon. 

Step 6. Marker jumps to Gfs maximum measurement point. 

Step 7. Marker data from the left, X value, Y1 value and Y2 value can be read. 

Figure 5-6. IGBT Ic-Vge for Expanders Application Test result. 

1.

6.

2.
3.

7.

5.

4.
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Chapter 5. Demo 3: Id-Vg and Ic-Vg measurement 

In the demo 3, following topics are covered: 

● Two application tests are demonstrated. 

- Id-Vgs for Expanders 

- Ic-Vce for Expanders 

● Both tests measure the transfer characteristics quite easily. 

These tests in ultra high current region were not so easy to perform before the 

introduction of UHCU of the B1505A. 

● These tests equivalently provide a constant voltage for Drain/Collector supply 

while sweeping the gate voltage. 

● The post analysis can be easily added after the measurement. 

Summary of Demo 3 
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Chapter 6. Demo 4: HVSMU & HVMCU Demo 

6-1. Demo setup 

6-Demo 4-1. IDSS & BVDSS Demo with HVSMU 

6-Demo 4-2. Id-Vd 1.1 A/2.2 kV & 2.5 A/1.5 kV Demo with HVMCU 

 

The objective of this chapter is the followings: 

● To perform the high-voltage test using HVSMU and HVMCU. 

● To learn the effect of 100 kΩ built-in series resistor. 

● To learn HVMCU operation and tips in high voltage and narrow pulse measure-

ments. 

 

● 3 kV maximum voltage of HVSMU 

● 1.1 A/2.2 kV or 2.5 A/1.5 kV maximum output of HVMCU 

 

 

Demo 4 uses the following device; 

IXTH1N250 high voltage power MOSFET 

- MOSFET: IXTH1N250 

  o VDSS:  2500 V 

  o Rds(on): Max. 40 Ω  

  o ID max.: 6 A @ 100 µs pulse, 5 kW @ Tc=25 °C  

Chapter 6. Demonstration 4: High-Voltage Measurement using HVSMU and 

HVMCU 

Idss/Vdss and High-voltage medium current Id-Vd characteristics 

Contents: 

Objective: 

Features: 

Device used: 

Wiring and Device setting inside of the N1265A Fixture: 

Use the same setup of section 3-1 and figure 3-1. 

10

100

1000

10000

0 10 20 30 40

C
a
p
a
c
it

a
n

c
e
 
(p

F
)

Vds (V)

Capacitance vs. Vds

Ciss

Coss

Crss

- Since the feedback capacitor from the 

drain to the gate is small, it is less im-

portant to consider the effect of  injec-

tion charge to the gate caused by  the 

drain pulse. 
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Chapter 6. Demo 4: HVSMU & HVMCU Demo 

In the demo system, two MCSMUs are shared between the HVMCU configuration 

and the UHCU configuration as shown in figure 6-1. 

The MCSMU cables are to be connected to the HVCE connectors for V/I control 

inputs (see  of figure 6-1).  

These cables are shared between the two modules (UHCE and HVCE), and have to 

be switched to the same named inputs of N1266A HVCE connectors from N1265A 

UHCE as shown in figure 6-1. 

 

This section, we assume the cable connection to the UHCE is already made. 

Therefore, we cover how to switch from the N1265A UHCE to N1266A HVCE in this 

section. 

 

Note: If you start B1505A system setup from the HVCE (HVMCU), then please make 

a cable setup by referring to the section 2-4, and continue the HVCE control VI 

cable connection by following the steps here after. 

 

 

1

6-1. Cable Connection between the B1505A and the Fixture/Expanders for HVMCU 

HVCE
N1266A

HV

GND

MC

MC

MC

B1505A

MC

MC

Interlock

GNDU

Input      Output

Input 

HVSMU

Output 

High

Output 

Low

F
S

F
S

F
S

Vcontrol F
Vcontrol S

I control F
I control S

F
S

F
S

Digital I/O cable (Included in N1266A)

Digital I/O cable (Included in N1265A)

Input

HVSMU

GNDU

N1265A (Selector built-in)

Gate F

Gate S

UHC Input 

V Control

I Control

For Gate

For UHC

For UHC

For Drain

For HVCE

For HVCE

16493T 16493T

16494A

16493L

16494A

16493L

Output

MCSMUs are shared between the 

HVMCE and UHCE`s control input 

configuration.
2

1

MP S
F Selector SMU F

Selector SMU S

Figure    6-1. Basic cabling block diagram for UHCU and HVMCU.    
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Chapter 6. Demo 4: HVSMU & HVMCU Demo 

◆ Switching the V/I control cables of the N1265A to N1266A: 

Follow the next steps and corresponding numbers shown in figure 6-2 to re-route 

the V/I control cables. 

Step 1. Remove the 16494A Triax Cable connected to the Sense of “V control” 

connector of the N1265A input. 

Step 2. Connect the removed cable to the Sense of “V control” connector of the 

N1266A input. 

Step 3. Remove the 16494A Triax Cable connected to the Force of “V control” 

connector of the N1265A input. 

Step 4. Connect the removed cable to the Force of “V control” connector of the 

N1266A input. 

Step 5. Remove the 16494A Triax Cable connected to the Sense of “I control” 

connector of the N1265A input. 

Step 6. Connect the removed cable to the Sense of “I control” connector of the 

N1266A input. 

Step 7. Remove the 16494A Triax Cable connected to the Force of “I control” con-

nector of the N1265A input. 

Step 8. Connect the removed cable to the Force of “I control” connector of the 

N1266A input. 

MPSMU 1

MCSMU 3

GNDU

MCSMU 4

MCSMU 5

HVSMU

Sense

Sense

Sense

Sense

Force

Sense Sense Sense

N1265A, N1266A Back Panel

B1505A 

Back Panel

1

Digital I/O

Interlock

7
N1265A

N1266A

MCSMU 2

HCSMU 6

MFCMU

4

3

5

Force

Force

8

2 6

Figure    6-2. Cable connection for N1266A HVCE by switching from N1265A UHCE and Fixture.    
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Chapter 6. Demo 4: HVSMU & HVMCU Demo 

Use the same setup of section 3-1 and figure 3-1. 

 

Set the test device (DUT) as shown in the next figure. 

We use the HV MOSFET: IXTH1N250 in demo 4 . 

Insert the MOSFET to the 3-pin socket (From the left, it is Gate, Drain and Source). 

Test Device setup 

Wiring and Device setting inside the N1265A Fixture 

IXTH1N250 

HV MOS 

Note:

The maximum voltage  of 

the socket is limited to 3 

kV !

G   D   S
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Chapter 6. Demo 4: HVSMU & HVMCU Demo 

�To Re-configure UHCU configuration (Pre-requisite): 

Before the configuration for the HVSMU/HVMCU, UHCU configuration has to be 

reconfigured to release the V/I control MCSMUs because these SMUs are shared 

between the two expander modules. 

 

Follow the next instruction by following the steps shown in figure 6-3. 

Step 1. Click Configuration icon. 

Step 2. Click "UHC Expander / Fixture" tab. 

Step 3. Click and disable the check box of "Enable Ultra Current Unit" as shown in 

the figure. 

This action will deactivate the control SMUs;  i.e. SMU3 for V Control SMU, 

and SMU4:MC for I Control SMU. 

Step 4. Change Default Output from UHC to NO selection (Blank) 

Step 5. Click "Apply" button.   

The UHCU is disabled in the configuration. 

6-2. EasyEXPERT Configuration for Expanders  to use HVSMU/HVMCU 

3.

4.

5.

1.
2.

Figure    6-3. Reconfigure UHC Expander to release the UHCU control SMUs.    
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Chapter 6. Demo 4: HVSMU & HVMCU Demo 

◆ To configure the HVSMU Current Expander (HVSMU/HVMCU): 

Follow the next instruction by following the steps shown in figure 6-4. 

Step 1. Click Configuration icon. 

Step 2. Click "HVMCU Expander" tab. 

Step 3. Click and mark the check box of "Enable High Voltage Medium Current 

Unit". 

Step 4. Select SMU5:HVSMU in the HVSMU Input select box. 

Step 5. Select exact the same Control SMUs for the V/I control SMUs` drop down 

list as you have configured in the B1505A cabling section. 

i.e. SMU2:MC for V Control SMU, and SMU3:MC for I Control SMU. 

Step 6. Click "Apply" button.   

The configuration is checked and applied. 

Step 7. Change the Default Output to SMU2: HVMCU. 

Step 8. Click "Apply" button renews the active selected module. 

Step 9. The selector indicator of N1266A on the front panel shows the current 

selector status. 

The example setup indicates the HVMC LED. 

3.

4.

5.

7.

6. 8.

2.

Figure    6-4. Configure the HVSMU Current Expander (HVSMU/HVMCU).    

9.
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Chapter 6. Demo 4: HVSMU & HVMCU Demo 

Setup of the N1265A Fixture`s selector configuration: 

Finally we have setup the N1265A Fixture`s selector configuration. 

Figure 6-5 shows the final configuration of the selector setup. 

 

◆ Final setup for N1265A selector: 

Follow the next instruction by following the steps shown in the figure. 

Step 1. Click "UHC Expander / Fixture" tab. 

Step 2. Set "HVSMU" in the input for HVSMU. 

Step 3. Set "HVSMU" in the default output of the selector. 

Step 4. Select "100 ohm" resistor from the list. 

Step 5. Click "Apply" button.   

Step 6. Click "Close" button to close the Configuration window. 

 

This is the end of the configuration to use HVSMU/HVMCU with the selector of the 

N1265A Fixture. 

The HVSMU LED should be lit on in the indicator of the N1265A as shown in the 

figure in the bottom. 

5.

6.

4.

1.

2.
3.

Figure    6-5. Final Configuration by setting HVSMU to N1265A Selector.    
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Chapter 6. Demo 4-1: IDSS & BVDSS Demo with HVSMU 

◆ To setup and measure the IDSS Tracer Test: 

Follow the next steps and the corresponding numbers shown in figure 6-6. 

Step 1. We use sample test setups. 

Click sample setups, then select MOSFET -> ID(off)-VDS. 

Step 2. Set the VAR1 sweep parameter as shown in the next table. 

The stop V is set as specified in the data sheet. (=BVDSS * 0.8 = 2,000 V) 

Step 3. Set Meas. time and Step time as shown in the figure (Default value). 

Meas. Time - 20 ms, Step Time= 20.1 ms. 

If you set very fast Meas. time, the measurement becomes noisy and may 

show higher leakage current. 

Step 4. Set CONST for SMU 2 as 0 V and 100 mA compliance. 

Step 5. Change X axis max. value to 3 kV. 

Step 6. Change Y axis max. value to 100 uA (Max. specification @ 25 °C is 25 µA). 

Step 7. Click Single measure button. 

The measurement trace is shown in the display. 

Demo 4-1. IDSS & BVDSS Demo with HVSMU 

6

4

2

3

9

1

10

7

8 5

Figure    6-6. Idss Tracer Test setup.    

Demo 4-1-1. IDSS Measurement 

Mode Start Stop NOS Interlacing Compliance Pwr comp
Output V

Comp
Hold Time

LIN-SGL 0 V 2 kV 101 1 1 mA OFF OFF 1 s
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Chapter 6. Demo 4-1: IDSS & BVDSS Demo with HVSMU 

Step 8. Click the marker button. The marker appears at 0 V. 

Step 9. Move the marker to 2.0 kV. 

Step 10. Read the marker value as IDSS at 2,000 V. 

The readout of the example shows -6 nA at 2,000 V, but this value can be 

considered as the noise level of the 1 mA range of HVSMU. 

Since the specification limit is 25 µA, the example device shows a very low 

leakage current.  

 

◆ To detect rough BVdss: 

Continue the next steps to figure out the breakdown voltage by following the corre-

sponding numbers if figure 6-7. 

Step 11. Change Meas. Time and the Step Time to 1 ms and 1.1 ms relatively. 

Note: If these time is too ling, the response time after you change the stop 

voltage by the rotary knob becomes very slow. 

The fastest Meas. Time is 500 µs. 

Step 12. Click repeat measure. 

Step 13. Click Stop V field to activate to change the parameter by rotary knob. 

Step 14. Rotate the rotary knob to increase the maximum sweep V to check rough 

breakdown voltage. 

Step 15. In the example, the breakdown voltage is about 2,850 V. 

12

15

13
14

11

Figure    6-7. BVdss detection by using the Tracer Test knob sweep.    
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Chapter 6. Demo 4-1: IDSS & BVDSS Demo with HVSMU 

Sometimes IXTH1N250 shows very high voltage breakdown characteristics as 

shown in figure 6-8. 

In that case, try the following workaround. 

Workaround 1: Try another IXTH1N250 sample if it shows the breakdown at below 3 

kV. 

Workaround 2: If workaround 1 does not work, try more demo 1XTH1N250 if you 

have more demo devices. 

Workaround 3: If above workarounds do not work, please try to change the HV 

MOSFET to the demo IGBT: FGA180N33ATD.  

FGA180N33ATD breakdowns at around 400 V (See the next figure). 

You can just replace the device and set the target voltage to about 

400 V, or highest 450 V. 

If your demo device does not show the breakdown as shown in figure 6-7. 

Figure    6-8. Example of higher than 3 kV breakdown of IXTH1N250 HV-MOSFET.    

IGBT: FGA180N33 ATD Breakdown characteristics

383V/0.3 mA
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Chapter 6. Demo 4-1: IDSS & BVDSS Demo with HVSMU 

◆ To setup and measure the BVDSS Tracer Test: 

Since we understand the breakdown voltage is higher than 2.5 kV, and the example 

HV MOSFET is about 2.85 kV, we will investigate the breakdown characteristics of 

the MOSFET in more detail. 

 

Follow the next steps and the corresponding numbers of the figure 6-9. 

Step 1. Change start voltage to 2.5 kV, and stop voltage to 2.6 kV. 

Step 2. Change the Compliance to 4 mA. 

Note: HVSMU can output maximum 4 mA in 3 kV range. Since the measure-

ment is very close to 3 kV, 4 mA is the largest current that we can use 

for this MOSFET test. 

Note that HVSMU can output 8 mA in 1.5 kV range. 

Step 3. Set the max, ID scale to 5 mA. 

Step 4. Set the min. VDS scale to 2.5 kV. 

Step 5. Click "Set stop condition area" icon, and change the yellow signal lit on. 

Step 6. Drag mouse to set the sweep stop condition area where a sweep stops 

when the measurement data once get in this area. 

Step 7. Click repeat measurement button, and activate the stop voltage field by click-

ing the VAR1 Stop field. 

 

The example test result shown in figure 6-10 can be obtained. 

Demo 4-1-2. BVDSS Measurement 

5

1

6

2

3

4

Click until Yellow signal turns on.

7

Figure    6-9. BVdss Tracer Test setup.    
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Chapter 6. Demo 4-1: IDSS & BVDSS Demo with HVSMU 

Step 8. Increase the voltage by rotating the knob. 

Step 9. When the measured data hit the stop condition area, the stop process starts, 

but there is some time delay until actually the measurement is terminated. 

Step 10. Click Marker icon, and check the breakdown voltage. 

Step 11. Click "Capture the reference trace" icon. 

The current trace is captured as a reference to compare the other measure-

ment results. 

 

Note: This reference trace is used in the next demo.  

 

Review: 

● Stop condition is useful to stop the sweep when it is difficult to detect the 

sudden current increase such as device breakdown. 

● V compliance can be used to limit the maximum voltage in knob sweep meas-

urement. 

8

10

9

11

Figure    6-10. Tracer Test knob sweep and detection of BVdss by hitting the stop condition area.    
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Chapter 6. Demo 4-1: IDSS & BVDSS Demo with HVSMU 

For BVDSS measurement, we can insert 100 kΩ series resistor to the output of the 

HVSMU output. 

By using 100 kΩ resistor, you can characterize a device with a negative resistance 

or a device that shows a snap back characteristics. 

The following demonstrates how the B1505A use the 100 kΩ resistor, and compen-

sate the voltage drop by the resistor. 

 

◆ To Setup the series 100 kΩ series resistor:  

Follow the next steps and the corresponding numbers in figure 6-11. 

Step 1. Open the Configuration of EasyEXPERT and click HVSMU Current Ex-

pander tab. 

Step 2. Check "Enable Series Resistor (100 kohm) for HVSMU" check box. 

Step 3. Click Apply button. 

Step 4. Click Close button. 

Note: In addition, adding the 100 kΩ series resistor to the drain HVSMU can prevent 

any potential damage to the DUT when abnormal breakdown status happens. 

Demo 4-1-3. Comparison of BVDSS with a series 100 kΩ drain resistor. 

3.

2.

1.

4.

Figure    6-11. To configure 100 kΩ resistor.    
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Chapter 6. Demo 4-1: IDSS & BVDSS Demo with HVSMU 

◆ To perform Breakdown test with 100 kΩ series resistor: 

Note: This test continues from the previous test. 

Follow the step numbers shown in figure 6-12. 

Step 1. Set stop V to 3 kV. 

Step 2. Click Option -> Arithmetic Operation, and then select Operation 1 and 

Operation 2. 

Step 3. Arithmetic Operation input field opens. 

Enter to #1 operation: Vdrp [V] = ID * Series R value. (98.7 k Ω in the ex-

ample) 

where Vdrp=V drop by 100 kΩ series R.  

Note: The nominal 100 kohm R must be calibrated for accurate break-

down measurement. 

Step 4. Enter to #2 operation: VD_cmp = VDS - Vdrp 

Where Vd_cmp stands compensated VD. You may use VD because 

VD_cmp does not fit in the column. 

Step 5. Click X axis name field and select VD_cmp. 

Step 6. Click single measure button. 

Measurement starts. 

Step 7. Sweep ends at 3 kV and breakdown curve is traced. 

Step 8. Click the marker button. The marker appears at 0 V. 

2

1

9

7

9`

6

8

3

5

4

10 11

Figure    6-12. To setup Arithmetic Operation function.    
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Chapter 6. Demo 4-1: IDSS & BVDSS Demo with HVSMU 

Step 9. Move the marker to about ID= 0.25 mA that is the breakdown specification 

point, and read the marker value as VDSS. 

It is 2.861 kV at 242 µA in the example. 

The specification is min. 2.5 kV at 250 µA, and this device used in the exam-

ple meets the specification. 

Step 10. Click Line/Dot icon. You can change the line type, and you can see exact 

measurement points in Dot line curve display as in the figure. 

As you can see, the measurement interval in reference trace without series 

R (blue) is much wider than the yellow trace with the 100 kΩ series resis-

tor. 

This is also a good point for using the series resistor when I/V curve is 

very steep. 

Step 11. You can on/off or delete or save reference traces by clicking "Select refer-

ence traces" icon 

 

Note: If you increase the measurement points, then you can get narrower steps in 

current reading. 

 

Review: 

● Series resistor is useful to precisely characterize the steep I/V portion to the 

devices with a sudden steep change of V/I characteristics, such as breakdown. 

● With the series resistor, a breakdown characteristics with a negative imped-

ance can be observed such as snap back characteristics. 

● Arithmetic function in the Tracer Test mode is useful for this type of measure-

ment. 

 

 

◆ To Disable the 100 kΩ  series resistor: 

Disable the 100 kΩ resistor before going to the next demo. 

Follow the next steps and numbers in the figure. 

Step 1. Open the Configuration of EasyEXPERT and click HVSMU Current Ex-

pander tab. 

Step 2. Un-check the "Enable Series Resistor (100 kohm) for HVSMU" check box. 

Step 3. Click Apply button. 

Step 4. Note: 

Make sure the UHC Expander is active 

by checking the N1265A LED status. 

If it is not active, make the UHC Ex-

pander to active status.  

Step 5. Click Close button. 

3.

1.

5.

4.

2.
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Chapter 6. Demo 4-2: Id-Vds using HVMCU 

◆ To setup and measure 2.2 kV Id-Vd characteristics: 

Follow the next steps and the corresponding numbers in figure 6-13 to setup the  

parameters. 

Step 1. Select Id-Vd sample setup. 

Step 2. Change SMU2:MC Mode to VPULSE. 

Step 3. Set VAR1 parameter as shown in next table by referring to figure 6-13. 

Step 4. Set initial stop voltage, say, to 10 V. 

Step 5. Set Measurement time setting as follows. 

Meas. Time = 10 us 

Step 6. Set VAR2 parameters as follows. 

Demo 4-2. Id-Vd 1.1 A/2.2 kV & 2.5 A/1.5 kV Demo using HVMCU 

7

6

5

4

3

9

8

1

10

11

2

Set 10 V at initial 

condition.

12

Figure    6-13. To setup 2.2 kV Tracer Test using HVMCU.    

Demo 4-2-1. Id-Vd 1.1 A/2.2 kV Demo 

Mode Start Stop NOS Interlacing Compliance Pwr comp
Output V

Comp

LIN-SGL 0 V 10 V 21 1 1.1 A OFF OFF

Pulse

Base

Pulse

Delay

Pulse

Width

Dual

Polarity
Hold Time

0 V 10 us 40 us OFF 0 s

Start Stop NOS Compliance Pwr comp
Pulse

Base

Pulse

Delay

Pulse

Width
Hold Time

2.8V 3.9 V 5 100 mA OFF 0 V 0 s 100 us 0 s
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Note: The Start and Stop voltage may require an adjustment depending on the Vth 

of you demo MOSFET. 

Step 7. Set VDS X axis max. scale to 2.5 kV. 

Step 8. Set ID Y axis max. scale to 1 A. 

Step 9. You can sweep up to 2.2 kV under the 1.1 A current compliance. The output 

resistance of the HVMCU is set t o 2.2 kΩ. 

The white dotted line is a load line determined by the maximum 2.2 kV drain 

supply voltage and the output resistance. 

The maximum I/V sweep area is limited surrounded by this dotted line, X=0 

V line and Y=0 A line. 

Step 10. Click repeat measure button. 

Step 11. Click Stop V to activate the modification. 

Rotate the rotary knob to increase the max sweep V to 2.2 kV by monitoring 

the measurement trace. 

Note: You may be required to change the VAR2 start and stop V to get the 

similar results as shown in the graph. 

You can change these parameters by focusing the mouse to these 

parameters, too. 

Step 12. The measurement trace moves toward the arrow direction. 

Finally you should achieve the similar results as shown in figure 6-13. 

Tips:  

Note: Pulse width could be narrowed down to around 30 µs with 2 µs Meas. 

Time setting. 

 

Try the following actions to measure the graph shown in figure 6-13. 

- For VAR2 START: Measure Vth of demo IXTH1N250 HV-MOSFET by referring the 

Demo 1 setup. 

Then set VAR2 START by rounding up the Vth in 0.5 V units. For 

example, if Vth = 3.1 V, enter 3.5 V. 

- For VAR2 STOP: Set VAR2 STOP by adding 1 V to 1.5 V to the START V value. 

Or gradually increase VAR2 STOP by 0.5 to 1 V step to maximum 6 V. 

Trouble shooting! 

If your measurement sticks on the base line as shown in figure 6-14. 

Figure    6-14. Example when 

VAR2 STOP V is too small.    
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◆ Oscilloscope view example: 

This demonstration uses relatively narrow pulse (40 µs) in the drain supply. 

In such a case, monitoring the pulse waveform is important. 

 

Following shows the steps to view the Oscilloscope View waveform. Refer the corre-

sponding number shown in figure 6-15.  

Step 1. Click Oscilloscope View icon. 

Step 2. Oscilloscope View window opens. 

Set Oscilloscope View parameters. 

Refer to Demo 2-2 for setting the parameters. 

Step 3. Starting the measurement displays the monitor point. 

Step 4. The voltage and Current  value of the monitored point are  displayed, 

and the waveform in the Oscilloscope view.  

Figure    6-15. Oscilloscope View of Id-Vd Tracer Test using HVMCU.    

1

3

2

4
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◆ To setup and measure 1.5 kV Id-Vd characteristics: 

Step 1. The stop voltage must less than 1.5 kV to use 2.5 A range. 

Set 1.5 kV for Stop V. 

Step 2. Set Compliance to 2.5A.  The output resistance of the HVMCU is set to 600 Ω. 

Step 3. Change pulse width to 30 us. 

Note: narrower the pulse width can generate more current in HVMCU, but too 

short pulse width tends to increase a measurement uncertainty. 

Step 4. Change Meas. Time to 6 us. 

Step 5. Change X axis max. value to 1.5 kV. 

Step 6. Change Y axis max. value to 2.5 A. 

Step 7. maximum V/I load line is shown. 

Step 8. Click repeat measure button. 

Step 9. The start and stop V of VAR2 require a small increase to increase the maxi-

mum current. 

Increase the current in 0.1 or 0.2 volts step so as you can make a similar 

measurement results as shown in figure 6-16. 

Step 10. Note: You can change stop V of VAR1, but once it exceeds 1.5 kV, the cur-

rent compliance changes to 1.1 A, and you will see unexpected results. 

Demo 4-2-2. Id-Vd 2.5 A/1.5 kV Demo 

6

7

2

5

1

3

8

9

4

10

11

Figure    6-16. To setup 2.5 A/1.5 kV Tracer Test using HVMCU.    
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Step 11. If you continue from the previous demo, there should be an Oscilloscope 

View window. 

Change the vertical and horizontal axis scale for properly monitoring the 

waveform. 

 

Review: 

● HVMCU covers a unique power range which covers 2 A and 2 kV range that 

were not covered in the past curve tracer. 

● The medium current coverage of this voltage range is useful for investigating 

the breakdown characteristics in high current condition, or SOA study on wafer 

level. 

- HVSMU has a built-in output resistor, and it is useful to protect the DUT 

   in such a case of sudden device breakdown. 

● Oscilloscope view is useful for narrow pulsed measurement such as less than 

30 µs range using HVMCU 

Summary of Demo 4 

In the demo 4, following topics are covered: 

● Maximum 3 kV test is possible with HVSMU. 

- Stop area setting is useful for breakdown test. 

- 100 kΩ series resistor and the arithmetic function are useful for  

   breakdown characterization. 

● HVMCU. covers unique power range: 2.5 A/1.5 kV or 1.1 A/2.2 kV. 

● HVMCU can output higher current at when the pulse width is narrower. 
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7-1. C-V Measurement using MFCMU and High Voltage Bias Tee 

7-2. Demo setup 

7-Demo 5-1. Low voltage Cdg measurement (40 V) 

7-Demo 5-2. High voltage Cdg measurement (1.5 kV) 

7-Demo 5-3. Test fixture connection for Cds, Coss and Cgs measurements 

 

The objective of this chapter is the followings: 

● To be able to perform the C-V measurement using the B1505A. 

● To be able to use AC guard technique to measure Cdg, Cds, Cgs. 

 

 

● 3 kV maximum DC bias voltage 

● Integrated C-V measurement capability on a ultra high power DC measurement 

instrument. 

 

 

Demo 5 uses the following device; 

● IXTH1N250 high voltage power MOSFET 

Chapter 7. Demonstration 5: High Voltage C-V Measurement 

Contents: 

Objective: 

Features: 

Device used: 

G    D   S
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F
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Capacitance vs. Vds

Ciss

Coss

Crss

Capacitance vs. Temperature data extracted from IXTH1N250 datasheet 
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Next three capacitive components of the power MOS-FETs are typically listed in the 

power MOS-FET datasheet. 

- Crss   Reverse Transfer capacitance  

- Coss   Output capacitance 

- Ciss   Input capacitance 

Figure 7-1 shows the intrinsic capacitive components of power MOS-FET which are 

gate- Drain capacitor Cgd, drain-source capacitor Cds and gate-source capacitor 

Cgs. 

Crss, Coss and Ciss capacitive components can be calculated by using Cgd, Cds and 

Cgs components as shown in the figure. 

This section provides how to measure the intrinsic capacitive components of power 

MOS-FET (Cgd, Cds, and Cgs). 

The demo exercises Cgd measurement. 

Each component can be measured independently by using the AC guard technique. 

 

◆ AC Guard and capacitive component measurement of MOSFET 

Following shows a basic MOSFET capacitive component measurement block dia-

gram for each parameter using the B1505A MFCMU, HVSMU, N1260A High Volt-

age Bias .Tee and N1265A Fixture. 

7-1. C-V Measurement using MFCMU and High Voltage Bias Tee 

Ciss: Input Capacitance

Coss: Output Capacitance

Crss: Reverse Transfer Capacitance

Ciss = Cgs + Cgd

Crss = Cgd

Coss = Cds + Cgd

Figure 7-1. 

Cds Measurement  

H

L

GND 

(AC Guard)

N1260A/N1265A

Cds

Cgs

Cdg
D

S

GIm

~

DC Bias   AC signal

Current meter

The picture shows the Cds measurement block diagram. 

7-1-1. Definition of Capacitance Parameters  
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Only the AC measurement signal passing through Cds component is measured by 

the Im current meter, and converted to Cds. 

The AC current passing through Cdg flows in AC Guard, and it does not affects to 

the Cds component. 

 

 

 

 

 

 

 

 

 

 

The picture shows the Cdg measurement block diagram. 

Only the AC measurement signal passing through Cdg component is measured by 

the Im current meter, and converted to Cdg. 

The AC current passing through Cds flows in AC Guard, and it does not affects to 

the Cdg component. 

Also the potential of L input is almost GND level, and the Cgd current branching off 

to Cgs component can be ignored since the potential between the Cgs is close to 

zero volts.  

 

Note: Due to the potential increase of the AC Guard impedance at higher frequency, 

sometimes the measurement signal leaks to Cgs component , and it cannot be 

ignored.  This effect may add errors in Cdg measurement accuracy. 

 

 

 

 

 

 

 

 

 

The picture shows the Coss measurement block diagram. 

Since the Gate and the source is connected together, all the current flowing through 

Cdg and Cds (equals to Coss) are measured by the Im current meter, and converted 

to Coss. 

Cds

Cgs

Cdg
D

S

G

H

L

GND 

(AC Guard)

Im

~

DC Bias   AC signal

Current meter

N1260A/N1265ACdg Measurement  

Cds

Cgs

Cdg
D

S

H

L

GND 

(AC Guard)

Im

~

DC Bias   AC signal

Current meter

N1260A/N1265ACoss Measurement  
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The figure shows an example configuration to measure the Cgs capacitive compo-

nent with a simple measurement setup. 

When measuring Cgs, one SMU is used to apply the drain bias parameter and it also 

provides the AC guard capability. 

At 100 kHz or lower frequency, the SMU impedance can be considered very low, and 

it can be used as an equivalent AC guard. 

The AC signal flowing through Cdg flows in to SMU, and only the AC measurement 

signal passing through the Cgs component is measured by the Im current meter, and 

converted to Cgs. 

 

 

Note: 

At higher frequency than 100 kHz, the SMU and the cable impedance becomes 

higher, and cannot be considered as AC guard. 

To measure Cgs at 1 MHz, the drain has to be equivalently guarded at that fre-

quency by connecting a large capacitor from the drain to the AC Guard. 

Cgs Measurement  

H

L

GND 

(AC Guard)

Cds

Cgs

Cdg
D

S

G

MP/HP 

SMU
SMU

F

S

F

N1260A/N1265A

Im

~
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◆ N1260A High Voltage Bias Tee 

To extend the DC bias voltage to maximum 3 kV, N1260A High Voltage Bias-Tee 

as shown in figure 7-2 is used. 

Note that the picture is cut in two parts to show both the input signal terminal 

and the output signal terminal. 

The DC bias is supplied by the HVSMU through a 100 kΩ resister. 

The AC measurement signal is provided through 110 nF capacitor to high output 

terminal. Since 110 nF capacitor is measured as a series connection with the 

measurement capacitor, this adds about 1 % additional capacitance error if the 

measured capacitance is about 1 nF. 

Note: The additional error can be considered roughly as "Measured capaci-

tance/110 nF x 100 %" when the measured capacitance is smaller than 10 nF. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Right figure shows the images of N1260A 

configuration with N1265A UHCE/Fixture. 

7-2. Demo setup 

Bias input from HVSMU

(HV Triaxial connectors)

Four terminal inputs from 

MFCMU

(BNC connectors)

CMU outputs

(SVH connectors)

CMU AC guard output

(SVH connector)

Modified, December 21, 2009

10
0 

kΩ

High

Low

110 nF
Hpot

Hcur

Lcur

Lpot

AC Guard
HVSMU

Output side viewInput side view

Lo
Hi

Hc
Hp

Lp
Lc

Figure 7-2. N1260A High Voltage Bias Tee. 

N1260A Setup example.
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◆ Connection overview between the N1265A, the N1260A and the B1505A 

Figure 7-3 shows a HV C-V configuration block diagram of the B1505A. 

The MFCMU of the B1505A measures the impedance and HVSMU provides the 

maximum 3 kV DC bias.  

These signals are integrated as the C-V measurement signal inside the N1260A HV 

Bias-Tee, and it is routed to the N1265A`s Fixture section to connect with the DUT. 

The connection between the MFCMU and N1260A HV Bias-Tee uses 4 terminal pair 

configuration. 

 

The connection between the HV Bias-Tee and the N1265A UHCE/Fixture is two 

terminal pair configuration. The error associated to this cable is reduced by per-

forming the Open and Short calibration after the power on of the B1505A. 

 

The Interlock circuit is provided to protect from the hazardous voltage. 

7-2-1. High Voltage C-V Measurement setup 

H

L

H

L

GND 

(AC Guard)

N1265A Fixture

H

L

HC

HP

LP

LC

N1260A

HV Bias-T

HC

HP

LP

LC

MFCMU

HVHVSMU

B1505A

InterlockInterlock

SMU1MPSMU
(Optional for Cgs measurement)

(Bias Tee)

(Bias Tee)

Figure 7-3. B1505A HV C-V measurement block diagram. 

◆ Cable connection of the 3 KV CV measurement configuration  

Figure 7-4 shows the overview of the cable connection for HV C-V measurement 

configuration. 

Cabling instruction: 

Follow the next steps and the numbers shown in the figure to route the cables. 

Step 1. Using a N1300A CMU cable, connect the connectors block side of the 

N1300A to B1520A MFCMU. 

First, mate all the connectors, and then insert the connector block to the 

B1502A MFCMU module as shown in the figure. 

After fitting the N1300A connecter block, tighten two screw to firmly fit the 

block to the B1502A MFCMU module.  
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Step 2. Connect the other end of the four connectors of N1300A CMU cable to the 

N1260A HV Bias-T input as shown in the figure. 

- Connect Red wire to Hcur 

- Connect Orange wire to Hpot 

- Connect Gray wire to Lpot 

- Connect Black wire to Lcur connector. 

   Note: Leave the Green wire open. 

Step 3. Using a 16493T HV Triax Cable, connect the Force connector on the B1513A 

HVSMU to the HVSMU input of the N1260A  

MPSMU 1

MCSMU 3

GNDU

MCSMU 4

MCSMU 5

HVSMU

Sense

Sense

Sense

Digital I/O

MCSMU 2

HCSMU 6

MFCMU

Force

Force

Sense

Force

Sense Sense

B1505A 

Back Panel

N1265A 

Back Panel

B1505A Back 

Panel

Leave this open

Input side 

N1260A High Voltage

Bias Tee

Output side 

1

Sense

4

3

5

6

2

7

Figure 7-4. Cable connection for HV C-V setup. 
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Step 4. Using 16493V SHV cable, connect Low output of the N1260A to the Low of 

the Bias Tee input of the N1265A Fixture.  

Step 5. Using 16493V SHV cable, connect High output of the N1260A to the High of 

the Bias Tee input of the N1265A Fixture. 

Step 6. Optional for Cgs measurements:  

Using a 16494A Triax Cable, connect the Force and Sense connectors on the 

lower B1511A MPSMU (SMU1) to the respective connectors on the SMU 

input 1 on the N1265A. 

Step 7. Using a 16493J Interlock Cable, connect the Interlock on the B1505A and the 

Interlock on the N1265A. 

 

 

Figure 7-5 shows the wiring example of inside the N1265A UHC Expander/Fixture 

for Cgd measurement. 

Route the cables/wire between the output terminal panel of the N1265A Test Fix-

ture and the inline package socket module as shown in figure 7-5. 

7-2-2. Wiring inside of the N1265A Fixture 

2. Collector/

Drain
1. Base/

Gate

Force       Sense Force       SenseForce       Sense

Base   Collector   Emitter

Gate      Drain       Source

3. Emitter/

Source

Inline Package Socket (3 Pin)

1  2  3  

3

12

Figure 7-5. Cable connection of the Cgd C-V measurement for N1265A Test Fixture. 
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◆ Wiring instruction: (Cgd) 

Follow the next steps and numbers in the figure to setup the wires inside the 

fixture 

 

Note: Use SHV cables for Bias Tee output that can withstand the 3 kV output of 

the HV C-V. 

Use the thinner wire for other connections. 

 

Step 1. Using the SHV cable, connect the Low of the Bias tee Output to the termi-

nal 1 Force 

(Base/Gate) on the Inline Package Socket. 

Step 2. Using the SHV cable, connect the High of the Bias Tee Output to the ter-

minal 2 Force 

(Collector/Drain) on the Inline Package Socket. 

Step 3. Using the universal wire, connect the GND/(AC Guard) Output of the 

N1265A Fixture to the terminal 3 (Emitter/Source) on the Inline Package 

Socket.  

 

SHV cable and SHV-Banana Adaptor Universal Force/Sense line wire 
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◆ To perform MFCMU calibration for "Open" compensation. 

Follow the next steps to calibrate the open compensation. 

Step 1. Setup the wiring of the test fixture. 

Step 2. Open the test fixture by removing any DUT from the socket. 

Step 3. Perform open calibration. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

◆ To start CMU "Open" calibration: 

Follow the next steps by following the numbers in figure 7-7. 

Step 1. Click Calibration ICON. 

Calibration window opens. 

Step 2. Click CMU Calibration tabs. 

Step 3. Make sure to "Open" the DUT terminal. 

Then click "Measure ..." button of "Open Correction" 

Step 4. Open correction starts. 

While in calibration "Measurement is in progress ..." is displayed. 

Step 5. A Check mark appears in the check box of "Open Correction" at when the 

correction is completed. 

7-2-3. MFCMU Open-Short compensation 

1.

2.

Remove  DUT from the socket

Open compensation

Figure 7-6. Setup for Open compensation. 
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◆ To perform MFCMU calibration for "Short" compensation. 

Follow the next steps by following the numbers in figure 7-8.. 

Step 1. Short between the pins of the test fixture socket using a short wire as 

shown in the figure. 

If you cannot find a proper wire, then use the method of next step. 

Step 2. (Optional in case step 1 is skipped.) 

Short between the input terminals of the socket module by using a short 

cable as shown in the figure. 

For Cgd short calibration, short between the sense input terminals of the 

Drain and the Gate. 

3.

1.

2.

4.

5.

Figure 7-7. Open calibration-compensation. 

Short Dain Gate pins for Cgd Calibration

Short compensation

1.

2. Optional:

Short Dain Gate at socket 

connector input pins.

Figure 7-8. Setup for  

Short compensation. 
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◆ To start CMU "Short" calibration: 

Follow the next steps by following the numbers in figure XX. 

Step 1. Make sure to "Short" the DUT terminal. 

Then click "Measure ..." button of "Short Correction" 

Open correction starts. 

Step 2. After "Measurement is in progress ..." is displayed for a while, 

a check mark appears in the check box of "Open Correction" at when the 

correction is completed. 

Step 3. Click Close button to finish the CMU Open-Short calibration. 

Step 4. Remove the short wire from the socket module. 

Set IXTH1N250 HV MOSFET to the 3 terminal inline socket. 

2.

1.

3.

Figure 7-9. Short calibration-compensation. 

IXTH1N250

HV MOS

G    D   S

4.
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1. To setup the C-V sweep measurement (Classic test): 

Follow the next steps by following the numbers of Figure 7-10. 

Step 1. Click Classic Test tabs. 

Step 2. Click C-V Sweep icon. 

Step 3. C-V sweep setup, Channel Setup page opens. 

Step 4. Click Add SMU. 

New Unit field opens. 

Step 5. Click Unit field. 

Available modules are listed in the pull down menu. 

Step 6. Click SMU6: HV to setup HVSMU as a DC sweep source. 

Step 7. Click SMU1:MP check radio button. 

Step 8. Click Delete button. 

SMU1:MP field is deleted. 

Step 9. Repeat steps 7 and 8, by leaving two lines for CMU1:MF and SMU6:HV. 

Demo 5-1. Low voltage Cdg measurement (40 V) 

1.

2.

3.

4.

5.
6.

8.

7.

9.

Figure 7-10. Cdg Classic test setup - Channel Setup tabs. 

10.

11.
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Step 10. Change the SMU6:HV parameters as follows: 

- VBias:   VD 

- I Name:   ID 

- Mode:   V 

- Function:  VAR1 

Step 11. Change Setup name to "Cgd-V Sweep" 

 

 

2. To setup the measurement parameters. 

Follow the next steps by following the numbers of Figure 7-11. 

Step 1. Click Measurement Setup tabs. 

Step 2. Change the Start, Stop, Step and Compliance parameters as shown in the 

figure. 

- Start:    0 V 

- Stop:   40 V 

- Step:   200 mV 

- Compliance:  8 mA 

Step 3. Set Delay time: 

- Delay:   200 ms 

Step 4. Set Frequency; 

- List:   1 MHz 

Figure 7-11. Cdg Classic test setup - Channel Setup tabs. 

1.

2.

3.

4.
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3. To setup the display parameters. 

Follow the next steps by following the numbers of Figure 7-12. 

Step 1. Click Display Setup tabs. 

Step 2. Set X and Y1 X-Y Graph parameters as shown in the figure. 

Step 3. Set List Display parameters as shown in the figure. 

Step 4. Make sure the HV MOSFET is set in the test module socket. 

Click Single Measure button. 

The Cgd sweep measurement starts, and Display window pops up. 

Step 5. Figure 7-13 shows an example Cgd sweep measurement curve of 

IXTH1N250 HV MOSFET. 

1.

2.

3.

4.

Figure 7-12. Cdg Classic test setup - Display Setup tabs. 

Figure 7-13. Cdg measurement example. 



130  

Chapter 7. Demo 5: High Voltage C-V Measurement 

◆ To measure 1500 V Cgd characteristics: 

Follow the next steps to measure the high voltage CV characteristics by following 

the numbers in figure 7-14. 

Step 1. Click Measurement Setup tabs. 

Step 2. Change VAR1 parameters as follows; 

- Linier/Log:  LOG10 

- Start:   100 mV 

- Stop:   1.5 kV 

Step 3. Change Timing parameters as follow; 

- Delay:   500 ms 

Step 4. Change Setup Name as Cgd-V Log sweep  

Step 5. Click Display Setup tabs. 

Step 6. Change X parameters as follows; 

- Scale:   Log 

- Min:   100 mV 

- Max:   1.5 kV 

Demo 5-2. High voltage Cdg measurement (1500 V) 

1.

2.

3.

4.

Figure 7-14. Modification for 1500V Cdg Classic test setup - Measurement Setup tabs. 

5.

7.

6.
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Step 7. Change Y1 parameters as follows; 

- Scale:  Log 

- Min:  1 pF 

- Max:  1 nF 

Step 8. Click Single Measure button 

1.5 kV log sweep measurement starts. 

 

Figure 7-15 shows an example 1.5 kV Cgd log sweep curve of the IXTH1N250 HV 

MOSFET. 

 

 

Review: 

● The CV measurement can be easily performed for both from low voltage to high 

voltage. 

● The maximum voltage can be going up to 3 kV. 

● Higher capacitance, say over 2 nF, can measure in better accuracy by connect-

ing the 4 terminal pair cables direct to the N1265A fixture by passing through 

the N1260A HV Bias Tee. 

Though, the maximum bias voltage is limited to 25 V in this case,. 

Figure 7-15. 1500 V Cdg log sweep measurement example. 
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This section provides the test fixture connection for other CV parameter measure-

ment. 

 

 

Demo 5-3. Test fixture connection for Cds, Coss and Cgs measurements 

2. Collector/

Drain
1. Base/

Gate

Force       Sense Force       SenseForce       Sense

Base   Collector   Emitter

Gate      Drain       Source

3. Emitter/

Source

Inline Package Socket (3 Pin)

1  2  3  

3

12

2. Collector/

Drain
1. Base/

Gate

Force       Sense Force       SenseForce       Sense

Base   Collector   Emitter

Gate      Drain       Source

3. Emitter/

Source

Inline Package Socket (3 Pin)

1  2  3  

3

12

Cds Measurement: 

Coss Measurement: 

Cgs Measurement: 

 

Note: 

1. The Cgs measurement requires to connect 

SMU1: MP to the SMU 1 Force input of 

the N1265A Fixture. 

- Set SMU 1 as VAR1. 

- Set HVSMU as Const=0 V. 

2. The maximum measurement frequency is 

limited to 100 kHz.  

3. Use the maximum fixed current range of 

MPSMU. 

2. Collector/

Drain
1. Base/

Gate

Force       Sense Force       SenseForce       Sense

Base   Collector   Emitter

Gate      Drain       Source

3. Emitter/

Source

Inline Package Socket (3 Pin)

1  2  3  

3

12
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In the demo 5, following topics are covered: 

● How to configure the high voltage C-V setup. 

● How to perform the Open-Short error compensation/calibration. 

● The maximum voltage of B1505A C-V measurement is 3 kV with the N1260A 

High Voltage Bias Tee . 

- We made the demo at 1.5 kV. 

- IXTH1N250 MOSFET can apply voltage to maximum 2.5 kV.  

● The reasonable maximum capacitance measured using the N1260A HV Bias 

Tee is about 2 nF if about 2% additional error is allowed. 

 

Note: Standalone use of MFCMU provides better accuracy for much higher 

capacitance measurements. 

But, the direct connection of MFCMU`s maximum DC bias voltage is limited 

to 25 V. 

Summary of Demo 5 
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Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

8-1. Demo setup 

8-Demo 6. High Voltage Diode Breakdown Test 

 

 

The objective of this chapter is the followings: 

● To be able to perform the ultra high voltage measurement using the N1268A 

Ultra High Voltage Expander of the B1505A. 

● We use two serial connected high voltage diode and experience a breakdown 

measurement at about 8 kV. 

 

 

● 10 kV maximum DC output for high voltage device testing. 

● Provides complete solution from 1500 A to 10 kV test for such device as IGBT 

 

 

Demo 6 uses the following device; 

● GP02-40 high voltage junction rectifier 

Chapter 8. Demonstration 6: 10 kV Measurement using UHVU 

Contents: 

Objective: 

Features: 

Device used: 

Major Ratings and Characteristics

IF(AV) 0.25 A

VRRM 4000 V

IFSM 15 A (60 Hz half sine-wave)

IR 5.0 µA

VF 30 V

Tj max. 175 °C
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Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

◆ Connection overview between the N1265A, the N1268A and the B1505A 

Figure 8-1 shows the Ultra High Voltage Expander configuration block diagram of 

the B1505A. 

Two MCSMUs are used to control the N1268A Ultra High Voltage Expander.  

The UHVU output is connected to the UHVU input of the N1265A Fixture. 

The digital I/O control is connected in serial by routing the N1265A and to the 

N1268A. 

The interlock circuit is routed the same way to control the output by both the 

UHVU and the test fixture. 

 

 

 

◆ UHVU cable configuration 

Figure 8-2 illustrates the cable connection from the B1505A through the N1268A 

UHVU Expander to the N1265A test fixture. 

Cabling instruction: 

Follow the next steps and the numbers shown in the figure to route the cables. 

Step 1. Using a 16494A Triax Cable, connect the Force and Sense connectors on 

the 3rd SMU from the bottom (MCSMU3) to the corresponding “Vset/Vm 

SMU” connectors of the UHV input of the N1268A. 

Step 2: Using a 16494A Triax Cable, connect the Force and Sense connectors on 

the 4th SMU from the bottom (MCSMU4) to the corresponding “Irtn SMU” 

connectors of the UHV output of the N1268A. 

8-1. Demo setup 

8-1-1. UHVU Configuration: Cable connection 

GND

MC

B1505A

MC

MC

F
S

F
S

F
S

HVSMU

GNDU

UHC Input 

V Control

I Control

N1268A UHV Exp

B1505A

MC

HC

InterlockInterlock

F
S

F

Digital I/O

UHV High

UHV Low

For Gate

For UHV

For UHV

Digital I/O

N1265A

UHV H
UHV L

Selector

High
Low

SMU 1

SMU 2

SMU 1

SMU 2

Gate H

Gate L

Gate F

Gate S

16493V

16494A x 45 ea.

16493L

Figure 8-1. B1505A UHVU measurement block diagram. 
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Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

Step 3. Using 16493V UHV cable, connect the HV Output of the N1268A to the 

UHV High connector of the N1265A Fixture. 

Step 4. Using 16493V SHV cable, connect the HV Return Input of the N1268A 

to the UHV Low connector the N1265A Fixture. 

Step 5. Using a 16493G Digital I/O Cable, connect the Digital I/O connector on 

the B1505A to the Digital I/O Input connector on the N1265A UHCE/

Fixture. 

Step 6. Using a 16493G Digital I/O Cable, connect the Digital I/O Output con-

nector on the N1265A to the Digital I/O connector on the N1268A. 

Step 7.  Using a 16493J Interlock Cable, connect the Interlock on the B1505A 

and the Interlock In on the N1268A. 

Step 8. Using a 16493J Interlock Cable, connect the Interlock Out on the 

N1268A and the Interlock on the N1265A. 

Step 9. Connect power cable to the B1505A, N1265A and N1268A. 

MPSMU 1

MCSMU 3

GNDU

MCSMU 4

MCSMU 5

HVSMU

Sense

Sense

Sense

MCSMU 2

HCSMU 6

MFCMU

Force

Force

1

Sense

For

ce

Sense Sense Sense

B1505A 

Back Panel
N1265A 

Back Panel

N1268A 

Back Panel

5

9

7

16493V UHV cable: High side

16493V SHV cable: Low side

6

3

8

2

4

B1505A 

Back Panel

9

Figure 8-2. Cable Connection for UHVU. 

UHV cable: High side

SHV cable: Low side
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Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

◆ Preparation of the Test Fixture  

Follow the next steps by referring to the numbers in figure 8-3. 

Step 1. Remove the test fixture socket module that is shown in #2. 

Unplug the cables only from the Test fixture side. 

Step 2. You can keep the cables as shown in the socket module. 

By leaving the cables as it is, you can re-configure the socket easier. 

Step 3. Insulation plate shown in back side in the figure has to set on the fixture 

for UHVU application. 

When set the insulation plate on the test fixture, meet the four pins of the 

insulation plate to the holes of the test fixture side. 

Step 4. The figure shows the picture after the insulation plate is set on the 

N1265A Test Fixture. 

Figure 8-3. N1265A Fixture setup for UHVU. 

3

1

2

4

Fit the pins

8-1-2. UHVU Configuration: Test Fixture 
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Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

We first deselect or inactivate the UHC and HVMCU to free the MCSMUs. 

Step 1. You can scroll the Configuration menu tabs by clicking the right-left direc-

tion arrows. 

Use this button and find the necessary configuration tab if it is hidden 

from the window. 

Step 2. Click UHC Expander/Fixture tab. 

Step 3. Un-check the "Enable Ultra High Current Unit" check box. 

Step 4. Un-check the "Enable Selector" check box. 

Step 5. Click "Apply". 

Step 6. Click "HVSMU Current expander" tab. 

Step 7. Un-check the "Enable High Voltage medium Current Unit" check box. 

Step 8. Click "Apply". 

8-1-3. De-select or un-activate the UHC and HVMCU configuration  

4.

1.2.

3.

5.

6.

7.

8.

Figure 8-4.  

EasyEXPERT Configuration. 
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Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

◆ UHVU Configuration  

Follow the next steps and the numbers in figure 8-5 to configure EasyEXPERT for 

UHVU. 

Step 1. You can scroll the Configuration menu tabs by clicking the right-left direc-

tion arrows. 

Use this button and find the necessary configuration tab if it is hidden 

from the window. 

Step 2. Click UHV Expander tab. 

Step 3. Check the "Enable Ultra High Voltage Unit" check box. 

Step 4. Set the Voltage and Current Control SMUs as shown in the figure. 

Step 5. Click "Apply". 

Please remember to turn on the N1268A before this action. 

Step 6. Click Close button. 

Figure 8-5.  

EasyEXPERT Configuration for UHVU. 

1.2.

3.

5.

6.

4.

Turn on N1285A before 

press "Apply" button.
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Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

◆ UHV cable set and demo Diode Setup in the fixture: 

Route the wire between the output terminal panels of the N1265A Test Fixture 

and clip the test diode as shown in figure 8-6. 

Follow the next steps and the number shown in the figure. 

Step 1. Set the SHV cable with an alligator clip to the Low output connector of 

UHV of the N1265A Fixture. 

Step 2. Set the UHV cable with an alligator clip to the High output connector of 

UHV of the N1265A Fixture. 

Step 3. Connect the Serial connected diode as shown in the figure in a direction 

that   the Cathode side (with a white belt on one end) to High side alliga-

tor clip and the other end to Low side alligator clip. 

Note: To serially connect the diode, twist the diode leads as the diode`s current  

direction become the same. 

The reason to make serial connection of the diode is to make the break-

down voltage about twice to show the UHVU capability at very close to 

the 10 kV maximum output. 

Step 4. Close the N1265A fixture cover. 

Make sure that any metal portion of the High and Low terminal of the 

diode side does not touch to the cover of the N1265A fixture as shown in 

figure 8-7. 

Demo 6. High Voltage Diode Breakdown Test 

Figure 8-6. UHV Diode setup inside the fixture. 

3

1
2

High side clip

Low side clip

High

Low



141  

Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

◆ To activate the output of the N1268A High Voltage Amplifier: 

Push "HV" button to activate the output of the N1268A High Voltage Amplifier 

before starting any measurements as shown in figure 8-8.  

Figure 8-7. Diode view when N1265A fixture cover is closed. 

Make sure the test cables and DUT do not touch to the inside 

fixture except the insulation plate.

Figure 8-8. HV indicator/button is lighted when UHVU is activated. 

Push "HV ON" key before 

starting the measurements.
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Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

◆ To Set Diode Breakdown Tracer test: 

Follow next steps and the numbers in figure 8-9 to setup the diode breakdown 

Tracer Test. 

Step 1. Click Tracer Test tab. 

Step 2. Click Sample Setups Icon. 

Step 3. Press Diode 

Step 4. Press IR-VR for measuring breakdown characteristics. 

 

 

 

◆ To setup and measure 10 kV Breakdown Test: 

Follow the next steps and numbers shown in figure 8-10. 

Step 1. Make sure that UHVU is set in the Unit field. 

Step 2. Set stop voltage;  

- Say 1V as a start up check of the measurement. 

Step 3. Set the parameter as shown in the figure. 

- NOS:  101 

- Compliance:  100 uA 

Step 4. Set the parameter as shown in the figure. 

- Meas. Time:  10 us 

- Step Time:  500 us 

Step 5. Set X axis max. to 10 kV. 

Step 6. Set Y axis max. to 100 uA. 

Step 7. Y axis Minimum is 0 A.  

Optional: Set Y axis min. to -10 uA to show the trace, if the leakage cur-

rent measurement shows a negative value and the trace does 

not appears on the display. 

3

4

1

2

Figure 8-9. IR-VR Diode breakdown sample menu. 
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Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

Refer to figure 8-11 from step 8. 

Step 8. Click the stop condition set icon (Yellow signal turns on). 

Step 9. Drag the area where you do want to stop the sweep when the measure-

ment data hit in the area. 

Step 10. Press Repeat measurement button. 

Step 11. Crick Stop voltage to activate the input 

Step 12. Rotate the knob to the right turn direction to increase the sweep maxi-

mum voltage. 

The sweep width grows to the right direction.  

Step 13. The sweep trace is growing to the right direction. 

4

7 5

2

3

6

1

Figure 8-10. UHV 10 kV test parameter setup 1. 

12

9

10

8

Drag to set stop condition area

11

13

Figure 8-11. UHV 10 kV test parameter setup 2 and knob sweep. 
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Chapter 8. Demo 6: 10 kV Ultra High Voltage Measurement 

Refer to figure 8-12 from step 14. 

Step 14. Finally, the diode breaks down and the sweep stops automatically when the 

measurement hit the stop condition area. 

Step 15. Click Marker icon. 

Marker appears on the measurement start point. 

Step 16. Move the marker to the breakdown start point. 

Step 17. You can read the breakdown voltage and the current of the marker. 

Step 18. Click Replay Traces icon. 

Step 19. Replay Trace control window opens. 

Step 20. Grab and move the bar to the left side will recall the measurement traces 

until the breakdown occurs. 

Replay Traces function is very useful, especially when the device is broken 

or damaged where you cannot re-create the same test. 

 

Note: You can save the trace and recall it later for offline review. 

 

Review: 

● The example shows the breakdown at around 9.4 kV.  

Since the breakdown voltage in the diode specification is minimum 4 kV, 9.4 kV 

breakdown in the demo example is reasonable with two diodes connected in 

series. 

14

15

16

17

18

19

20

Figure 8-12. UHV 10 kV breakdown test example and the analysis. 
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Chapter 9. Demo 7: Thermo-trigger function 

Demo 7. Vth shift measurement using the Thermo-triggering 

 

 

The objective of this chapter is the followings: 

● Learn Thermo-trigger function. 

● Experience Vth shift versus case temperature measurement using Thermo-

trigger function. 

 

● Temperature dependent parameters can be easily taken by using the Thermo-

trigger function. 

● Temperature dependent parameter example: 

- Transfer Characteristics (Vth, Vgs-off) 

- Saturation voltage 

- ON resistance 

- Breakdown voltage 

- Forward voltage drop (Diode) 

 

IRFP4004 HC MOS 

 

 

 

 

 

Vth vs. Temperature data extracted from IRFP4004PbF datasheet 

Chapter 9. Demonstration 7: Thermo-trigger function 

Contents: 

Objective: 

Features: 

Device used: 

2

2.5

3

3.5

4
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V
g

s
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h
) 

 (
V

)

Tj, Temperature  (°°°°C)

Vgs(th) vs. Tj @ Id=250 µA
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Chapter 9. Demo 7: Thermo-trigger function 

Test flow of Vth shift measurement using the Thermo-trigger function: 

Thermo-trigger demo measures the Vth drift of the power MOSFET. 

The test procedure is shown in figure 9-1. 

Follow next steps by referring to the numbers shown in the figure. 

Step 1. First, the MOSFET case/body temperature is heat up by using self heating 

of the Ig-Vd repeated measurement. 

Step 2. After about 8 °C temperature rise, we start Vth measurement by using the 

thermo-trigger function. 

Step 3. Each Vth measurement is triggered by following the pre-defined Thermo-

trigger list. 

Step 4. In the demo, two thermocouples are used, one to measure the MOSFET 

body temperature and the other to measure the test fixture temperature 

as a reference to measure the relative temperature rise of the MOSFET. 

IRFP4004

HC MOS Self-heat

the MOSFET

T1-rise> 

8°C ? NO

YES

Start Thermo-trigger 

measurement

Thermocouple: T1

Thermocouple: T2

T1-T2 <> 

T Radius? NO

Trigger Vth  

measurement

T List 

END ?

YES

End of Thermo-trigger 

measurement

YES

Set Thermo-trigger

Target Temperature: T  

Thermo-trigger List

NO

Thermo-trigger

Repeat 

Measurement

1.

2.

3.

4.

Figure 9-1. Test flow of the Vth shift measurement. 
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Chapter 9. Demo 7: Thermo-trigger function 

Route the wire between the output terminal panel of the N1265A Test Fixture and 

the inline package socket module as shown in the figure. 

 

◆ Wiring instruction: 

The SMU wiring is the same as the Vth measurement in section 3-1. 

Refer to section 3-1 to set the wiring inside the test fixture. 

To set the thermocouple to the N1265A Fixture: 

- Set two thermo couples to the "K. Thermocouple #1 and #2 inputs socket as 

shown in figure 9-2. 

Note: The detail is shown in next. 

 

 

2. Collector/

Drain
1. Base/

Gate

Force       Sense Force       SenseForce       Sense

Base   Collector   Emitter

Gate      Drain       Source

3. Emitter/

Source

Inline Package Socket (3 Pin)

1  2  3  

+--+--

1 2

Figure 9-2. Thermo-trigger wiring. 

N1265A-041

Thermocouple (3m leads)

+--

Backside View

Type K thermocouple plug

1

6

5

4

3

2

7

Figure 9-3. Thermocouple setup. 
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Chapter 9. Demo 7: Thermo-trigger function 

◆ Thermocouple setup: 

Set the thermocouples by following the next steps and numbers shown in figure 9-3. 

Step 1. Set thermocouple K socket to the N1265A #2 thermocouple input socket. 

Step 2. The enlarged socket is shown. 

Step 3. Insert the thermocouple socket as shown in the figure. 

There are thick (- mark) and thin (+ mark) side in the socket, and meet the 

same type when mating the socket module. 

Step 4. The picture shows the enlarged back side of the socket. 

Step 5. Put #2 thermocouple to the base of the socket module by using sellotape. 

Step 6. Set another thermocouple to #1 socket of the N1265A. 

Step 7. Put #1 thermocouple to the back side plate of the MOSFET. 

◆ EasyEXPERT Configuration setup 

Before starting the measurements with UHCU, UHC Expander/Fixture configuration 

is necessary. 

To Configure UHCU: 

Follow the next instruction by following the steps shown in figure 9-4. 

Step 1. Click Configuration icon. 

Step 2. Click "UHC Expander / Fixture" tab. 

Step 3. Click and mark the check box of "Enable Ultra High Current Unit". 

Note: V/I control SMU should be set already. 

Step 4. Click and mark the check box of "Enable Selector". 

Step 5. Make sure check mark is set for Enable Gate Control. 

Step 6. Select SMU1:MP for default output. 

Step 7. Check both the Channel 1 and 2 of the Thermometer field. 

Step 8. Click "Apply" button.   

Click "Apply" button renews the active selected module. 

Step 9. Click "Close" button to close the Configuration window. 

3.

4.
5.

8.

2.

6.

7.

9.

Figure 9-4.  

EasyEXPERT 

Configuration: UHC. 
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Chapter 9. Demo 7: Thermo-trigger function 

◆ Setup of "Vth Vgs(off)" Application test: 

For measuring the Vth, we use the same setup used in chapter 3 Demo 1 as shown 

in figure 9-5. 

Follow the steps shown in figure 9-5. 

Step 1 to 5: 

Use the same setup of Demo 1, Vth measurement. 

Note: Make sure the following two points: 

- MeasMode : Vth 

-Vth is defines at Id = 250 uA. 

Step 6. Click Single Measure button, and check if the Vth obtained is reasonable. 

 

 

Figure 9-5. Vth setup of Vth Vgs(off) application test. 

3.

2.

4.

5.

6.

1.
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Chapter 9. Demo 7: Thermo-trigger function 

◆ To setup the Thermo trigger list: 

Follow the next steps and the numbers in figure 9-6. 

Step 1. Click Application Test tabs. 

Step 2. Click Run Options button. 

Run Option window opens. 

Step 3. Check "Record Test Data Automatically" check box. 

Note: If this check box is set and repeat measurement is executed except the 

Tracer Test mode, Repeat measurement Setup window opens when the re-

peat measure button is clicked. 

Step 4. Click Repeat Measure button. 

Step 5. Repeat measurement Setup window opens 

Step 6. Check "Automatically fill in Device ID" check box. 

Step 7. Check "Enable Thermo-trigger" check box. 

Step 8. Click "N1265A Thermo-trigger List ..." button. 

Step 9. Thermo-trigger List box pops up. 

Step 10. Click #1 line of Temp cell. 

Step 11. click T1-T2 setup. 

 

Follow the steps shown in figure 9-7 from step 12. 

Step 12. Set the parameter of #1 line as follows; 

- Center:  5 deg. C 

- Radius:  0.5 deg. C 

- Leave the other parameters as the default set. 

Step 13. Click Add button. 

New entry field opens. 

Set the parameters as shown in column 2 of Thermo-trigger List of figure 9-

7. 

Figure 9-6. Setup the Thermo-trigger List 1. 

2.
3.

4.

5.

8.7.

9.

10.

11.

1.

6.
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Chapter 9. Demo 7: Thermo-trigger function 

Step 14. Repeat step 13 for column 3 to 5 of the Thermo-trigger List and fill the pa-

rameters as shown in the following table. 

 

 

 

 

 

 

Step 15. After setup all the thermo-trigger list, Click OK button. 

Now the temperature list is setup in the EasyEXPERT menu. 

Note: If you re-use the list, you can use the Export and Import function. 

Step 16. Check "Counter reaching to:" check box. 

Step 17. Set counter number to 5. 

Since the Thermo-trigger list is 5, the measurement stop condition is set to 

5. 

Step 18. Check "Reset counter before repeating" check box. 

By this setup, the repeat counter is reset to zero when starting the repeat 

measurement, and the counter increment one at each repeat measurement 

Step 19. Now, we click "cancel" at this time to return to setup, because we have to 

start the self-heating measurement at first..  

Figure 9-7. Setup the Thermo-trigger List 2. 

12.

13.

14.

15.

17.16.

18. 19.

Temp Center Radius Delay Action

1 T1-T2 5 deg. C 0.5 deg. C 0 s TRG

2 T1-T2 4 deg. C 0.5 deg. C 0 s TRG

3 T1-T2 3 deg. C 0.5 deg. C 0 s TRG

4 T1-T2 2 deg. C 0.5 deg. C 0 s TRG

5 T1-T2 1 deg. C 0.5 deg. C 0 s TRG
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Chapter 9. Demo 7: Thermo-trigger function 

◆ ID-VDS Tracer Test setup for self-heating: 

Set ID-VDS Tracer Test by following the next steps and numbers shown in figure 9-8. 

Step 1. Set the following VAR1 and VAR2 test parameters by selecting ID-VDS sam-

ple menu. 

Step 2. Now the thermo-couple temperature is shown in real time in this field. 

Click the field and set to show dT: T1-T2 deg. C. 

Step 3. Click Repeat measure button. 

The repeat measurement starts, and temperature of the MOSFET starts to 

rise.  

Step 4. The temperature rise is shown in real time in Thermometer field. 

When the dT reaches about 8 deg. C, Click Stop Measure button for chang-

ing to the thermo-trigger Vth measurement. 

Note: The temperature of the MOSFET starts to cooling down, and we have to start 

the thermo-trigger Vth measurements before the MOSFET cools down to 6 

deg. C dT. 

Figure 9-8.  

ID-VDS Tracer 

Test Setup. 

2.

3.

1.

4.

4`.

Mode Start Stop NOS Interlacing Compliance Pwr comp
Output V

Comp

LIN-SGL 0 V 60 V 21 1 501 A 3 kW 35 V

Pulse

Base

Pulse

Delay

Pulse

Width

Dual

Polarity
Hold Time

0 V 0 s 100 us OFF 0 s

Start Stop NOS Compliance Pwr comp
Pulse

Base

Pulse

Delay

Pulse

Width
Hold Time

4.5 V 6.5 V 5 100 mA OFF 0 V 0 s 120 us 0 s

VAR1

VAR2
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Chapter 9. Demo 7: Thermo-trigger function 

5.

6.

7.

8.

9.

10.

11.

12.

◆ To start Thermo-triggered Vth measurement: 

Follow the steps shown in figure 9-9 from step 5. 

Step 5. Click Application Tab. 

The Vth measurement setup should be there. 

If not, maybe you can recall from My Favorite setup or from the Result data 

area. 

Step 6. Click Repeat Measure button. 

Repeat Measurement Setup window opens with the previously set condition. 

Step 7. Click Run button. 

Step 8. The first measurement starts when the dT is reached within the radius of the 

target temperature. 

Step 9. While waiting the trigger temperature, the target temperature is displayed. 

Step 10. The real time temperature is shown. 

Step 11. The Vth measurements are repeated and the status of the thermo-trigger list 

is renewed to the latest one. 

Step 12. dT is renewed also.  

Figure 9-9. Thermo-triggered Vth Test. 
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Chapter 9. Demo 7: Thermo-trigger function 

Figure 9-10 shows an example data display of Vth measurements. 

#1. The Vth measurements triggered by the thermal-trigger list are saved in the 

Results area. 

#2. Each measurement extracts Vth in the Parameter field. 

#3. The T1, T2 and dT (=T1-T2) are automatically saved in the Device ID field. 

 

We can easily extract the Vth and the T1 data, and figure 9-11 shows an example 

Vth plot from this demo results. 

Figure 9-11 plots T1 versus Vth that is extracted from the demo measurements. 

The linear regression line is drawn, and it shows the Vth temperature coefficient of 

IRFP4004 is -9.2 mV/°C. 

2.

3.

1.

Figure 9-10. Vth Display Data by Thermo-triggering. 

y = -0.0092x + 3.4803
3.165

3.17

3.175

3.18

3.185

3.19

3.195

3.2

3.205

3.21

29 30 31 32 33 34

V
th

 (
V

)

Temperature (DegC)

IRFP4004 Vth vs. Case Temp.

Vth

Figure 9-11. Vth shift vs. case temperature. 
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Chapter 9. Demo 7: Thermo-trigger function 

Review: 

● The extracted temperature coefficient of Vth in figure 9-11 is -9.2 mV/°C. 

The value from the datasheet (see the first page of chapter 9) can be read 

about -9 mV/°C temperature coefficient for ID=250 µA curve at around 25°C 

case temperature. 

● It is a good match with the test result from the B1505A. 

● We used self heating to increase the MOSFET temperature, but there would be 

another choice such as to use hear dryer to warm up the MOSFET. 

 

 

Through the demonstration, the following items are covered; 

● How to use the thermocouple. 

● How to operate the Thermo-trigger function. 

● Using auto-analysis, the automatic Vth extraction in the Application Test is 

very easy to extract device parameter. 

Note: Using Classic Test mode can implement the auto analysis capability 

quite easily. 

Next chapter demonstrates such an example. 

● The demo results can expect a good much with the datasheet parameter. 

Summary of Demo 7 
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Chapter 10. Demo 8: Tracer Test to Classic Test Conversion 

10. Demo 8: Tracer Test to Classic Test conversion. 

 Automatic parameter extraction. 

 

 

This demo covers the conversion of the Tracer Test setup to a new Classic Test 

mode test definition. 

 

By converting the Tracer test to a Classic test definition, the following merit can be 

obtained. 

● Auto ranging mode for current measurement is applied (as default) to cover 

wide range and accurate measurement. 

Note: Tracer Test mode uses fixed range to keep the maximum speed. 

● Auto analysis can be added easily. 

● More X-Y graph display format can be added for each test. 

● List Display can check many data and data status.  

● Tracer Test sample setup menu can be used to setup the measurement portion 

of the Classic test mode definition. 

By using this approach, a tedious setup process of the basic test setup of the 

Classic Test mode can be elimi-

nated. 

Chapter 10. Demonstration 8: Tracer Test to Classic Test conversion 

Automatic parameter extraction 

Contents: 

Objective: 

Features: 

Marker readings:

• Rds(on) = 1.65 mΩ 

@ Id= 195 A
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Chapter 10. Demo 8: Tracer Test to Classic Test Conversion 

In the Demo 2-3-1, we measured RDSon ID-VDS (see Tracer Test in previous page). 

In this demo, we convert this Tracer test definition to a Classic test definition, and 

then, add an auto-analysis capability. 

In the Classic test definition, we are adding the following operations to extract Rds. 

1. Activate Marker. 

2. Move the marker to Id = 195 A. 

3. Read Rds(on) value at the marker position. 

4. Display Rds (on) to the Parameter display field. 

 

◆ To Convert Test Definition from Tracer Test to Classic Test: 

You can easily convert the Tracer Test mode definition to the Classic Test mode. 

Please recall the Rds(on) Tracer Test setup for converting it to a Classic test 

mode . 

Follow the next steps and numbers shown in figure 10-1.; 

Step 1. Set a proper test name in Setup Name field. (RDSon ID-VDS) 

Step 2. Click Save button on your proper group of My Favorite Setup. 

Step 3. The Tracer Test definition is saved to Rds_ON My Favorite group in the 

example. 

Step 4. Click Classic Test mode tab. 

Classic Test mode GUI opens. 

Step 5. Select target Tracer test definition by clicking on the icon in My Favorite 

Setup area.  

Click RDSon ID-VDS Tracer Test icon in the example. 

Step 6. Click Recall button. 

Tracer Test mode definition is automatically converted to Classic Test 

mode definition. 

4

1

2

3

6

Tracer Test mode          Classic Test mode

5

Figure 10-1. Tracer Test mode to Classic Test mode test definition conversion. 
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Let`s check the converted classic test definition. 

All of the parameters are converted as shown in figure 10-2 for; 

Step 1. Channel Setup, 

Step 2. Measurement Setup. 

Step 3. Sweep status is the same. 

Step 4. ADC time is 50 us. 

Step 5. Pulse settings are the same. 

Step 6. User Function: RDSon is converted. 

Step 7. Display set up for X-Y Graph is converted. 

Note that List Display is added for the same parameter of X-Y Graph. 

1

2

3

4

5

Figure 10-2. Tracer Test mode to Classic Test mode test definition conversion. 

6

7
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Chapter 10. Demo 8: Tracer Test to Classic Test Conversion 

You can add an automatic analysis capability in the Classic Test mode. 

◆ To Add Automatic Analysis Function: 

Follow the next steps and the numbers in figure 10-3 to add the automatic analy-

sis capability. 

Step 1. Click Auto Analysis Setup tab. 

Step 2. Set Marker as shown in the figure: 

- Check Enable Maker check box. 

- Enter the marker analysis condition to ID = 195 A that is the  

  specification condition of the Power MOSFET. 

Step 3. Set Interpolation Mode to active by clicking the check box. 

Step 4. Click the Function Setup page. 

Step 5. Set Analysis Function as shown in the figure. 

Note: @MY1 function reads the Y1 axis data of the marker, and the equa-

tion set the @MY1 value to the Rds_on variable. 

We are going to display this data in the Parameter  Display field. 

1

.

.

.

2

3

4

5

Figure 10-3(a). Adding Auto Analysis on Classic test definition. 
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Chapter 10. Demo 8: Tracer Test to Classic Test Conversion 

Continued from the previous page. 

Step 6. Open the Display Setup page by clicking the tab. 

Step 7. Add X-Y Graph parameter as shown in figure 10-3(b). 

Step 8. Add parameters in List Display. 

Step 9. Add the Rds_on parameter to the Parameters field. 

Step 10. Set a proper Classic Test Setup Name. 

The example put "CT" that denote Classic Test. 

Step 11. Click Save button. 

Step 12. This action will save the new test definition to My Favorite Setup group in 

classic Test mode. 

Step 13. Click Single Measure button. 

6

7

8

10

9

12

11

13

Figure 10-3(b). Adding display parameters on the Display Setup tabs. 
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Chapter 10. Demo 8: Tracer Test to Classic Test Conversion 

The ID-VDS CT classic test results are shown in figure 10-4.. 

The demo example output is explained by following the next steps and the numbers 

shown in figure 10-4. 

Step 1. X-Y Display plots RDS0n - ID curve. 

Step 2. Marker is automatically locates at specified ID=195 A point. 

Step 3. The marker Y1 axis data is shown as extracted parameter in the Parame-

ters field. 

On resistance is 1.64 mΩ that is lower than the 1.7 mΩ specification at 

ID=195 A. 

Step 4. List display lists all the specified parameters with marker position with a 

highlight. 

 

Now, you can refer to these parameters handy without any additional operations. 

Step 5. Note, optional: 

Clicking "Show Graph Legend" displays the setup parameters on the X-Y 

graph. 

 

Conclusion: 

● Converting Tracer Test to Classic test definition is quite simple 

● Adding Automatic Analysis and Display parameters are also a very easy task. 

● The combination use of the Tracer Test mode and the Classic Test mode pro-

vides easy to use environment on the B1505A. 

1

2

3

4

5

5

Figure 10-4. Rds_on vs. Id characteristics: Classic test result with auto analysis capability. 
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Chapter 11. Demo 9: Reporting 

Demo 9: Reporting 

This demo handles the topics relating the reporting. 

When you make a repot, such activity as analyzing data, converting data and trans-

ferring data between your application software, is necessary. 

Demo 9 covers the following topics. 

1. Desktop EasyEXPERT 

2. Display/Recall Data 

3. Copy Graph 

4. Copy List data 

5. Export/Import Results Data 

6. Export/Import My Favorite Preset group 

Chapter 11. Demonstration 9: Reporting 

     Data Analysis on your PC 

Contents: 
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Chapter 11. Demo 9: Reporting 

Option: Use of Desktop EasyEXPERT 

Using Desktop EasyEXPERT for reporting purpose is a good alternative idea. 

● Because it is off-line, you can access to your measurement data at anytime if 

once your measurement data is exported from the B1505A and imported to your 

Desktop EasyEXPERT. 

● Since you can use your PC, you can use your familiar application for farther ana-

lyzing the measurement data and creating your report. 

● If your desktop area is large, it surely improves the data handling inside Desktop 

EasyEXPERT and your applications. 

 

Note:  This demo does not require Desktop EasyEXPERT. 

If to use Desktop EasyEXPERT, refer to Appendix 2. 

 

 

 

Note: On-line use of the Desktop EasyEXPERT software 

Desktop EasyEXPERT can be used on line as exactly the same way as EasyEX-

PERT on the B1505A if your PC and the B1505A is connected via GPIB.  

Therefore you can access to the B1505A measurement recourses without export-

ing your test library which is developed on your off-line PC or new setups.  

The measurement data is automatically saved on your Desktop EasyEXPERT, and 

there is no need to export the Results data from the B1505A and importing to 

your PC. 

 

1. Use of Desktop EasyEXPERT

• Off-line* test & analysis environment

• Benefit:

• Improve the efficiency

• Can access to EasyEXPERT and the measurement data at 

any time.

• On your PC environment

• Measured data processing for familiar Windows 

application.

• Maybe, large screen work area

• Off-line

• No B1500A H/W required

• Test library development.

*: Can be used on-line if connected to the B1500A via GPIB
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Recall or Re-Display Result Test Data For Analysis 

The Test results saved in the List data area of EasyEXPERT can be recalled or 

displayed in any time. 

The data recalling capability is useful for  analyzing your data and making a report 

after all the data is taken or after you move the data to Desktop EasyEXPERT. 

There are following two ways to display the test result. 

Display Data: Displays only the test data in data display window. 

You can make analysis on the displayed data. 

Recall: Recalls both the data display window and the setup data. 

Recalling data is useful when you need to check the measurement setup, or 

want to make a measurement again after reviewing your data. 

 

◆ To Recall/Display Data: 

To Recall/Display Data in the Results area, follow the next steps by referring to 

the numbers in the slide. 

1. Right click on the data line, or  

select a line -> click Results bar opens the function menu. 

2. Click Display Data or Recall. 

2. Recall/Display Data

1.

2.
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To Copy Graph Plot 

The above slide shows an example of the copy and paste operation. 

The graph displayed on the data display window can by copied to the clipboard. 

You can paste the graphic image to other Windows application, for example, a word 

processing software.  

 

 

◆ To Copy Graph: 

In the above example, the graph image is pasted to the WordPad. 

To copy Graph, follow the next steps by referring to the numbers in the slide. 

1. Open the data display window to copy. 

2. From the file menu, select the "Edit > Copy Graph menu" on the Data Dis-

play window. 

3. Open WordPad (or other application) 

- Select the Edit > Paste menu on the WordPad. 

3. To Copy Graph Plot

Paste to WordPad

1.

2.

3.



166  

Chapter 11. Demo 9: Reporting 

To Copy List Data 

The above slide shows an example of the copy and paste operation. 

The data list shown on the data display window can be copied to the clipboard. 

You can paste the data to other Windows application, for example, Window Note-

pad software.  

 

◆ To Copy List Data: 

In the above example, the data list is pasted to the Notepad. 

To copy List data, follow the next steps by referring to the numbers in the slide. 

1. Open the data display window to copy. 

2. From the file menu, select the "Edit > Copy List" menu on the Data Display 

window. 

3. Open Notepad (or other application) 

- Select the Edit > Paste menu on the Notepad. 

 

Note:  The copied data is the same format as displayed in the List display area. 

If you past the data to a spreadsheet for analysis, you may need to change 

the number format in List area. 

(See next page.) 

 

Note:  Copy Parameters function 

As same as the Copy List function, the Copy Parameters function is used to 

copy the data in the Parameters area. 

4. To Copy List Data

Paste to Notepad

Open by a spreadsheet software

1.

2.

3.
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There are several formats in displaying the List Display. 

The dialog box shown in above slide is used to set the data display format in the List 

Display area. 

◆ To Open the List Display Properties Dialog box: 

To open the List Display Properties dialog box, follow the next steps by referring to 

the numbers in the slide. 

1. Click the "Properties..." button in the List Display area or 

2. Select "Edit > List Display Properties..." menu of the Data Display window.  

3. List Display Properties box opens. 

Display area:  

Check the following check box to add the data status or the physical unit to data. 

Un-checking the box removes it. 

• Data Status: Adds or removes the status code before data. 

• Physical Unit: Adds or removes the physical unit after data. 

Number Format area:  

Selects the data display format from the following formats. 

• Engineering Format (with Unit Prefix): 

Data display with arithmetic point, SI prefix, and unit. 

Example: -1.2345 mA 

• Scientific Notation: 

Data display with arithmetic point, exponential part  

(E, +/- sign, and three-digit number), and unit. 

Example: -1.23456789012345E-003 A 

Note: 

For Spread sheet calculation,  use these properties: 

(Check only "Scientific Notation") 

4-1. To Change List Display Properties
Edit > List Display Properties…

Example: -1.2345 mA

Example: -1.23456789012345E-003 A

Example: C -1.2345 V

Data Status

Physical Unit

2. 1.

3.

To Copy List Data in a Different Format to use with Spread Sheet Application 
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5-1. To Export Test Record

1. Select data record to export, and right click.

2. Select Transport Data > Export As xxxx.

To export multiple data, select Transport Data > Folder Export.

Text File Export Filter GUI

Suggested format to 

export the test record.

1.

2.

3.
4.

To Export Measurement Data Record 

The measurement data can be exported to the external file in a format that the other application 

can be used. 

◆ To Export the Test Record: 

To export the test result record, follow the next steps by referring to the numbers in the slide. 

1. Specify the data records to export. 

2. Click Result button and display the function menu. 

3. Select the "Transport Data > Export As xxxx" from the menu list. 

xxx denotes the available format. 

Windows Explore opens. 

4. Specify the file name and the directory to save the data. 

Note: Multiple test records can be exported in one file by using "Transport Data > Folder 

Export…" menu. 

There are the following five formats to export the test record: 

• (Compressed) Test Result file: Used to transfer between EasyEXPERT. 

• CSV file: Comma delimited text file.  

• XML spreadsheet file: A XML file created by using the specified XML style sheet. 

• My Format: Delete some part of unnecessary data by using a filter file. 

• Text File format: Export only the necessary data by using a GUI based filter. 

◆ Export File Suggestion: 

There are many export file format and filter combination. The filter is used to extract the nec-

essary data element from the EasyEXPERT internal database. 

The  following format is suggested for easy-of-use and satisfactory result for first step users. 

• "Export as Compressed Test Result ...": Used to transfer between EasyEXPERT. 

• "Export as Text File...": Used to transfer data between the Windows application. 

Make sure to set the "Text File Export Setting ..." when using this format. 
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To Import Test Record to EasyEXPERT 

The measurement data can be imported to the EasyEXPERT. 

This operation would be useful when you move the data to Desktop EasyEXPERT 

for off-line analysis and creating a report. 

 

Note: 

Only the file exported as "Test Result" or "Compressed Test Result" format can 

be imported. 

 

◆To Import the Test Record: 

To import the test result record, follow the next steps by referring to the num-

bers in the slide. 

1. Click Result button and display the function menu. 

2. Select the "Transport Data > Import..." from the menu list. 

The Test Result Import dialog box is opened. 

3. Select the file to import. 

5-2. To Import Test Record

1.

2.

3.
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Export/Import My Favorite Preset group 

You can export/import your preset group. 

This operation would be useful when you move the preset group between the 

B1505A and Desktop EasyEXPERT. 

 

◆ To Export: 

To export the present preset group, follow the next steps by referring to the num-

bers in the slide.. 

1. Click the My Favorite Setup button 

2. Click Preset group 

3. Select "Export This Preset Group...", and specify the folder and the name of 

the preset group to export.  

◆ To Import: 

To import the preset group, follow the next steps by referring to the numbers in 

the slide.. 

1. Click the My Favorite Setup button 

2. Click Preset group 

3. Select "Import Preset Group...", and specify the preset group to import.  

 

6. To Export/Import Your Preset Group

My Favorite Setup

button

1.
2.

3.
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Demo 9: Summary 

 

We learned the topics/items listed in above slide. 

 

 

 

Demo 9: Summary

We learned following in this lab:

1. Desktop EasyEXPERT

- Off-line data handling is important to improve the job efficiency in many ways.

- It can be used on-line (to control B1500A from your PC), too.

2. Display/Recall Data is essential for post processing your data.

3. Following functionality is useful for making a report:

- Copy Graph

- Copy List data

- Export/Import Results Data

- Export/Import My Favorite Preset group
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◆ To Turn off the B1505A: 

If this is today`s final demo work on the B1505A,  

1. Take off the demo device from the test fixture. 

2. Then turn off the B1505A. 

2A. Press the Standby switch (lower right corner of the front panel), 

or perform Windows shutdown from the Start menu.  

2B. EasyEXPERT is closed and Windows will be safely shut down 

and the Agilent B1505A will enter the standby state.  

To Turn off the B1505A 
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Appendix 

Appendix 

 

Table of Contents: 

Appendix 1. Updating the Application Test Library for EasyEXPERT rev. A.05.00 
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Appendix 2. Desktop EasyEXPERT Software 

Appendix 3. Before returning the demo-B1505A 

A3-1. Saving the measured data 

A3-2. Deleting the workspace and measured data 

Appendix 4. Returning the Demo B1505A 
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Download the application test definition file-set from the Agilent web site by follow-

ing the next procedure. 

Procedure: 

- Web site:  

Visit www.agilent.com/find/B1505A and go to Technical Support area. 

Find “B1505A MB3 Demo” and zip file indicator. 

- Download: 

By clicking the link, you can download "B1505A_MB3_Demo_AT.zip" Application 

Test Library file. 

Save it to a proper folder of the B1505A`s Windows system, say D:/tmp or desk-

top. 

A1-1-1. Download the example file-set from the Agilent web site 

Appendix 1. Supplemental Information for Preparation  

Earlier shipment of the demo B1505A did not include the revision A.05.01 EasyEX-

PERT Application Test Library that is used in the demonstration.  We are also re-

quired to modify two existing Application Test libraries to meet the demo require-

ments. 

If your EasyEXPERT revision is A.05.00, then please download the necessary files 

from Agilent web site, and install them before starting the demo. 

● To check the EasyEXPERT revision 

Open the configuration window of the EasyEXPERT as shown in figure A1-1. 

The following section instructs the download and installation procedure. 

Please follow the next instructions.  

A1-1. New Application Test installation for EasyEXPERT revision A.05.00 

1

2

3

Figure A1-1.  
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1. Right click zip file

2. Select “Extract All”

4. Press  “Extract”

3. Select/Set the folder 

to extract zip files

5. Zip file is extracted

Figure A1-2. Extracting the downloaded zip file. 

A1-1-2 Extracting from zip compressed file 

The downloaded file has to be extracted to the regular Windows file format for read-

ing from EasyEXPERT. 

Follow the steps shown in figure A1-2 for extracting files from the downloaded zip 

file. 

Step 1: Right click the B1505A_P-BJT_HB_Library.zip file. 

Step 2: Select "Extract All ..." menu from the pop up window. 

Step 3: Extraction Window opens, and click "Next". 

Step 4: Select desktop for extracting from the downloaded zip file. 

Then click  "Next". 

Step5. Windows Explore opens. 

All the files are extracted under the specified folder. 

In the example, "B1505A_MB3_Demo_AT" folder on the desktop. 
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Figure A1-3. Importing the Application Test definitions.  

2. Press “Library”

3. Select  “Import Test Definition”

4. Find the imported library set,

and select them.

5. Press “Open”

6. Check 

“IGBT” & 

"PowerMOSFET"

check box.

8. New 

Application Test 

Definitions

7. Enter "Ex" in the 

search field”

1. Press 

“Application Test”

Import the Application Test definition to EasyEXPERT by following the next steps. 

[PROCEDURE] - See figure A1-3 

Step 1: Press “Application Test” tab. 

Step 2: Press “Library” bar of EasyEXPERT.  

Library menu opens  

Step 3: Select “Import Test Definition” from the Library menu. 

Windows Explorer opens. 

Step 4: Find the folder where you extract the example file set. 

And select two Application Test definitions as shown in the figure. 

Step 5: Press “Open” of the Windows Explorer button. 

All the Application Test definitions are imported in to the EasyEXPERT Appli-

cation Test Library. 

Step 6: Check IGBT and PowerMOSFET check box of the Application Category field. 

All the Application Test definitions included to theses categories show up in 

the Library field. 

Step 7: Enter “Ex” to the search box.  

Only the Application Test definitions with “ex” in the test  name appears on 

the Library field. 

Step 8: The new Application Test definitions appear in the Library window. 

Check if these Application Test definition exist. 

A1-1-3 Setup of the downloaded Application Test files to the EasyEXPERT soft-

ware 
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The following two Application Test Definitions included in the EasyEXPERT revision 

A.05.00 do not support MPSMU that is used in the demonstration to measure Vth of 

the IGBT and the power-MOSFET. 

● Vth Vgs(off): Vth or Vgs(off) measurement (A.05.00) 

● Vth Vge(off): IGBT Vth or Vge(off) measurement (A.05.00) 

These two Application Test definitions have to be modified before the demo. 

 

Note: MPSMU is supported in later revision than EasyEXPERT Rev. E.A.05.01, and 

you do not need to make the modifications described in this section. 

 

A1-2-1. Modification of Vth Vgs(off) - Power MOSFET:  

Follow the next steps and the numbers of figure A1-4 to modify the Application Test 

definition for Vth Vgs(off). 

Step 1. Click “Application Test” tab. 

Step 2.& 3. Check “IGBT” and “PowerMOSFET” Application category. 

Step 4. Enter “Vth” in the search field. 

Step 5. Right click the Vth Vgs(off) test definition. 

Application Test definition menu opens. 

Step 6. Click “Open Definition of This Test ... ” 

Test definition editor window opens (Figure A1-5) 

A1-2. Modifying the Vth measurement Application Test definitions 

1.
1. 2.

3.

4.

5. 6.

Figure A1-4. To open the Application Test definition. 
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Step 7. Test definition editor is shown. 

Step 8. Scroll down the vertical bar of the Test Parameter Definitions area until 

Drain term shows up. 

Step 9. Click line area of the drain term to focus the control. 

Step 10. Click Resource Types button. 

Step 11. Define Resource Type window opens. 

Step 12. Click “Add” button. 

New resource input field is added. 

Step 13. Select MPSMU from the resource menu. 

Step 14. MPSMU is set as an available resource type. 

Step 15. Click Close button. 

Figure A1-5. To modify the Application Test definition.  
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Step 16. Click File -> Save 

Step 16. “Confirm Test Definition Overwrite” window pops up. 

Step 17. Click “OK” to confirm the overwrite of the test definition. 

Close the Application Test editor. 

 

 

 

 

 

 

A1-2-2. Modification of Vth Vge(off) - IGBT:  

Modify the Vth Vge(off) Application Test definition by following the same steps for 

the Vth Vgs(off) from figure A1-4 to A1-6 by changing the step 8 as follows:. 

 

Replace step 8 line of figure A1-5 with the following step. 

Step 8. Scroll down the vertical bar of the Test Parameter Definitions area until 

Collector term shows up. 

Figure A1-6. To save the new Application Test definition.  

A1-2-1. Modification of Vth Vgs

(off):  



180  

Appendix 2 

You can install Desktop EasyEXPERT software on your Windows PC. 

Desktop EasyEXPERT holds exactly the same capability of the B1505A`s EasyEX-

PERT, and it expands your B1505A demonstration in the following aspects; 

1. You can keep all the measurement results made on demo B1505A, 

and recall the test results after you return the demo B1505A or even 

in offline. 

2. You can check EasyEXPERT functionality in offline. 

3. You can use a larger window area of your PC when analyzing your 

data with the PC software. 

4. If you want, you can control B1505A from your PC as the same way 

as the native B1505A`s EasyEXPERT. 

 

● To Install Desktop EasyEXPERT Software 

Follow the instruction of the Desktop EasyEXPERT installation. 

 

● To Start Desktop EasyEXPERT (Offline Mode): 

1. Click the "Desktop EasyEXPERT" icon on your Windows desktop. 

 

2. Start EasyEXPERT window opens 

 

3. Before starting Desk-

top EasyEXPERT, we 

set Desktop EasyEX-

PERT options as shown next. 

Step 1. Click "Option". 

Step 2. Click "Execution Mode..." 

Execution Mode window opens. 

Desktop EasyEXPERT has following two operation mode;  

1. Online mode:  

Such as B1505A, B1500A and 4155/56 B/C can be controlled 

via GPIB. 

2. Offline mode:  

Creating application library and data analysis can be made.  

Appendix 2. Desktop EasyEXPERT Software 

1. 

2. 

5. 

4. 

3. 
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Step 3. We`ll select offline mode. 

Check "Offline". 

Step 4. Select measurement model: Click "B1505A" 

Step 5. Click "OK", and close the Execution Mode window. 

 

4. Click Start EasyEXPERT button. 

 

Offline mode B1505A Desktop EasyEXPERT opens. 

 



182  

Appendix 3 

If your practice of this measurement handbook is with an Agilent Demo B1505A, you 

may want to keep your measurement data for future reference and want to delete 

your foot print from the Demo B1505A before returning it to Agilent. 

This section provides information about this topic. 

 

You can save the measurement data in several formats. 

This section introduces to save the data in EasyEXPERT format so that you can im-

port the data to B1505A or Desktop EasyEXPERT for keeping the maximum flexibility 

for managing the data. 

You can download Desktop EasyEXPERT software and can install to your Windows 

PC. 

Please keep the original Application Test library of this measurement handbook if 

you are exporting your data as EasyEXPERT format.  

When you upload your data to Desktop EasyEXPERT software, you are required to 

install the Application Test library first before importing the measurement data in 

case where the parent application library is not installed in the EasyEXPERT. 

 

[Exporting procedure] 

Follow the instructions shown in figure A3-1. The number in the figure corresponds 

to the following step number. 

Step 1. Click the upper arrow for expanding the results area. 

Step 2. Results area expands as shown in the right side figure. 

Step 3. Select the data to export. Selected data changes the background color to 

blue as shown in the figure. 

Step 4. Left click "Results" bar. 

Result area menu opens. 

Step 5. Select "Transport Data".  

Next menu appears. 

Step 6. Select "Export As Compressed Test Result ...". 

Then "Compressed Test Result Export" Explore opens.  

Enter file name and save your data to an appropriate recording media. 

 

Note: Your saved data is the same format as the example results data used in this 

measurement handbook. 

Use the same steps when you recover your data in different EasyEXPERT software. 

Appendix 3. Before returning the Demo B1505A 

A3-1. Saving the measurement data 
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1

2

3

4

5

6

Figure A3-1. Expanding the Results area and select measurement data sets.  
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Deleting of your foot print from the Demo B1505A is easiest by deleting your work-

space from the Workspace management page. 

You can open the Workspace management page by standard startup process or us-

ing the methods shown in section 2-5-1. figure case 1. 

Figure A3-2 shows the steps for deleting existing Workspace. 

Follow the instruction steps as follows. The instruction steps match the number in 

the figure. 

Please be careful doing your work since there is no way for recovering the data once 

it has been erased. 

 

[Deleting procedure] 

Step 1. Check "Your Workspaces:". 

Step 2. Press "Manage Workspace" button. 

Step 3. Workspace manager sub window opens. 

Step 4. Select the Workspace name from the "Available Workspaces:" list. 

Step 5. Press "Delete" button. Confirmation sub-window pops up. 

Step 6. Press "OK" button in the Confirmation sub-window. 

Your Workspace is deleted with all of your data and setups from EasyEXPERT. 

A3-2. Deleting the workspace and measured data 

2

1

3

6

4
5

Figure A3-2. Deleting existing Workspace from EasyEXPERT. 
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When returning the Demo B1505A, please make sure all the items are packed as 

delivered to you. 

Please make sure to delete your workspace created for the demonstration for pro-

tecting any of your private data. 

Refer to appendix B section for deleting your workspace. 

 

In addition, please be sure to delete any confidential data stored in the EasyEXPERT 

or Windows file system. 

 

 

Note: 

Agilent technologies will not delete any of the data 

when renting the demonstration B1505A to the next 

user. 

 

Appendix 4. Returning the Demo B1505A 
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